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ABSTRAK 

 

Aizah Arum, E. 2015. Perbedaan Penguasaan Konsep Photoshop Antara Siswa 

yang Diajar dengan Metode Brainstorming dan Metode Tanya Jawab. Skripsi, 

Jurusan Teknik Elektro Fakultas Teknik Universitas Negeri Semarang. 

Pembimbing Dra. Dwi Purwanti, AhT, M.S. 

 

Penelitian ini bertujuan untuk mengetahui apakah terdapat perbedaan 

penguasaan konsep siswa yang diberikan pembelajaran dengan menggunakan 

metode brainstorming dan metode tanya jawab pada siswa kelas X Jurusan RPL 

di SMKN 10 Semarang. Jenis penelitian ini adalah quasi eksperimen dengan 

desain pre test post control group design.Populasi penelitian ini adalah seluruh 

siswa jurusan rekayasa perangkat lunak di SMKN 10 Semarang.Subjek penelitian 

yaitu kelas X RPLI sebagai kelas kontrol dan X RPL II sebagai kelas eksperimen. 

Instrumen yang digunakan adalah soal tes pilihan ganda. 

Data dianalisis dengan menggunakan uji normalitas, uji homogenitas, uji-t 

dan uji N-gain.Dari hasil perhitungan gain diketahui  bahwa peningkatan 

penguasaan konsep photoshop siswa pretest dan posttest kelompok eksperimen 

yang menggunakan metode brainstorming sebesar 5,333 dan kelompok kontrol 

yang menggunakan metode tanya jawab sebesar 4,969  dan t tabel sebesar 2,025.  

Dengan demikian dapat disimpulkan adanya peningkatan yang signifikan 

antara  pretestdan posttest masing-masing kelompok. Untuk hasil uji thitung(6,54) 

lebih besar dari ttabel (1,99). Besarnya peningkatan pemahaman konsepyang diukur 

dengan N-gain juga menunjukkan kedua kelas berada pada kriteria sedang, pada 

kelas eksperimen (0,54) lebih besar dibandingkan kelas kontrol (0,31). Sehingga 

dapat diambil kesimpulan bahwa terdapat perbedaan yang signifikan antara 

penguasaan konsep photoshop yang menggunakan metode brainstorming dan 

metode tanya jawab. 

 

Kata Kunci: Penguasaan Konsep, Metode Brainstorming, Metode Tanya 

Jawab 
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BAB I 

PENDAHULUAN 

 

1.1 Latar Belakang 

Banyak siswa yang berasumsi bahwa pelajaran desain grafis yang 

diberikan di sekolah itu sulit dan membosankan sehingga banyak siswa yang 

kurang tertarik dengan pelajaran photoshop, itulah pendapat dari siswa – siswi 

jurusan rekayasa perangkat lunak di SMK Negeri 10 Semarang pada umumnya. 

Hal ini terjadi akibat penyajian materinya yang bersifat penugasan dan tidak 

menggunakan metode yang tepat sesuai dengan materi. 

Salah satu faktor yang menentukan keberhasilan pembelajaran adalah 

penggunaan metode pembelajaran. Metode pembelajaran yang digunakan 

hendaknya dapat memberikan hasil yang baik, efisien, dan efektif. Oleh karena 

itu, guru dituntut untuk dapat menggunakan metode pembelajaran yang dapat 

merangsang aktifitas dan minat peserta didik dalam belajar serta sesuai dengan 

tujuan pembelajaran yang akan dicapai. Menurut Sudjana (2013: 76) metode 

mengajar ialah cara yang dipergunakan guru dalam mengadakan hubungan 

dengan siswa pada saat berlangsungnya pengajaran.  

Berdasarkan  pada uraian di atas, maka permasalahan yang diangkat 

adalah bagaimana menggunakan metode pembelajaran yang tepat untuk 

menciptakan peserta didik dengan kemampuan yang baik. Maka tidak hanya 

diperlukan proses belajar mengajar tradisional saja yang hanya mementingkan 

pengalaman belajar sesuai sesuai dengan kurikulum, namun lebih dari itu 
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diperlukan proses belajar mengajar yang dapat membangkitkan penguasaan 

konsep peserta didik dan memberikan pengalaman praktik sebagaimana kondisi 

yang sebenarnya pada mereka. 

Salah satu potensi manusia yang dapat berperan dalam menentukan tingkat 

keberhasilan pembelajaran adalah penguasaan konsep atau pemahaman materi. 

Pemahaman suatu konsep dengan baik sangatlah penting bagi siswa, karena dalam 

memecahkan masalah siswa harus mengetahui aturan-aturan yang relevan dan 

aturan-aturan ini didasarkan pada konsep-konsep yang diperolehnya. Untuk itu 

diperlukannya metode yang sesuai untuk mengembangkan penguasaan konsep 

siswa.  Diantara berbagai macam metode yang dapat digunakan dalam proses 

pengajaran, diantaranya adalah metode brainstorming dan metode tanya jawab. 

Menurut Roestiyah ( 2012: 73)  metode brainstorming adalah suatu teknik 

atau cara mengajar  yang dilaksanakan oleh guru di dalam kelas dengan cara 

melontarkan suatu masalah ke kelas oleh guru, kemudian siswa menjawab atau 

menyatakan pendapat sehingga masalah tersebut berkembang menjadi masalah 

baru atau dapat diartikan juga sebagai suatu cara untuk mendapatkan banyak ide 

dari sekelompok manusia dalam waktu yang singkat. 

Dalam brainstorming siswa diperbolehkan mengemukakan gagasan apa 

saja yang muncul dari pikiran masing-masing, tidak dibenarkan adanya 

kritik,karena adanya kritik dapat merintangi gagasan sehingga akan meningkatkan 

partisipasi siswa dalam menerima pelajaran. 

Adapun metode tanya jawab adalah metode mengajar yang memungkinkan 

terjadinya komunikasi langsung yang bersifat two way traffic sebab pada saat 
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yang sama terjadi dialog antara guru dan siswa (Nana Sudjana, 2013:78). Metode 

ini dapat digunakan untuk meninjau ulang pelajaran yang telah disampaikan  

dalam proses pembelajaran sebelumnya. Metode ini lebih menanamkan kepada 

pemahaman dan ingatan siswa terhadap materi yang sedang atau telah dipelajari. 

Setelah melakukan studi pendahuluan di SMKN 10 Semarang, ternyata 

banyak siswa yang pasif pada saat pembelajaran berlangsung dan  menyepelekan 

tugas yang diberikan guru pengampu. Selain itu dalam proses pembelajarannya 

pun guru masih menggunakan metode tanya jawab, belum pernah mencoba 

menggunakan metode brainstorming dalam pembelajaran photoshop terhadap 

penguasaan konsep siswa.  

Berdasarkan hal tersebut akan diteliti sampai sejauh mana perbedaan 

pengguasaan konsep photosop antara siswa yang diajar dengan metode 

brainstorming dan metode tanya jawab pada pokok bahasan membuat desain 

template website menggunakan photoshop untuk kelas X, jurusan rekayasa 

perangkat lunak di SMKN 10 Semarang. Disamping itu penelitian ini diharapkan 

dapat memberikan masukan positif bagi pengaplikasian keilmuan yang diperoleh 

di Lembaga Universitas Negeri Semarang (Unnes). 
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1.2 Identifikasi Masalah 

Dari uraian latar belakang masalah yang telah dijelaskan di atas, maka 

dapat diidentifikasi masalah – masalah sebagai berikut : 

1. Apakah metode mengajar brainstorming dapat meningkatkan penguasaan 

konsep siswa dalam pelajaran komputer ( photoshop ) ?. 

2. Apakah belum terbiasa dengan belajar berkelompok dan siswa yang pasif 

merupakan kendala yang dihadapi dalam proses pembelajaran dengan 

metode brainstorming ?. 

3. Bagaimanakah perbedaan peningkatan penguasaan konsep siswa yang 

menggunakan metode brainstorming dan metode tanya jawab ?. 

4. Bagaimanakah peningkatan penguasaan konsep siswa yang menggunakan 

metode brainstorming dan metode tanya jawab ?. 

1.3 Pembatasan Masalah 

Mengingat keterbatasan dalam kemampuan meneliti dan luasnya 

permasalahan yang hendak dibahas, serta untuk lebih terarahnya penelitian ini, 

maka permasalahan hanya dibatasi pada perbedaan metode mengajar 

brainstorming dan metode tanya jawab terhadap penguasaan konsep siswa kelas 

X SMKN 10 Semarang. Penguasaan konsep siswa dibatasi pada nilai tes awal dan 

akhir pelajaran photoshop. 
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1.4 Perumusan Masalah 

Berdasarkan uraian diatas, maka masalah penelitian ini dirumuskan 

sebagai berikut: “Apakah terdapat perbedaan penguasaan konsep siswa yang 

diberikan pembelajaran dengan menggunakan metode brainstorming dan metode 

tanya jawab pada siswa kelas X Jurusan RPL di SMKN 10 Semarang?” 

1.5 Tujuan Penelitian 

Tujuan yang ingin dicapai dalam penelitian ini adalah : 

1. Untuk mengetahui apakah metode mengajar brainstorming dapat 

meningkatkan penguasaan konsep siswa dalam pelajaran komputer              

( photoshop ). 

2. Untuk mengetahui apakah belum terbiasa dengan belajar berkelompok dan 

siswa yang pasif merupakan kendala yang dihadapi dalam proses 

pembelajaran dengan metode brainstorming. 

3. Untuk mengetahui bagaimana perbedaan peningkatan penguasaan konsep 

siswa yang menggunakan metode brainstorming dengan metode tanya 

jawab. 

4. Untuk mengetahui bagaimana peningkatan penguasaan konsep siswa yang 

menggunakan metode brainstorming dengan metode tanya jawab. 
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1.6 Manfaat Penelitian 

Penelitian ini ditujukan untuk memberikan manfaaat kepada semua pihak  

yang terkait langsung dalam dunia pendidikan, terutama bagi : 

1. Kepala sekolah, sebagai informasi untuk lebih meningkatkan mutu 

pendidikan jurusan rekayasa perangkat lunak (RPL). 

2. Guru – guru jurusan RPL, informasi ini dapat dijadikan suatu referensi dan 

masukan dalam memilih dan memberlakukan metode mengajar yang lebih 

efektif dalam pelajaran komputer, terutama pada pemahaman konsep 

photoshop. 

3. Siswa, memberikan pengalaman belajar yang dapat meningkatkan 

pemikiran intelektual siswa, untuk dapat mengaplikasikan keilmuannya 

didalam kehidupan bermasyarakat sebagai wujud dalam pembangunan 

bangsa dan negara disegala aspek kehidupan.  

1.7 Penegasan Istilah 

Untuk menghindari salah penafsiran dan kesalahpahaman terhadap skripsi 

yang berjudul “Perbedaan Penguasaan Konsep Photoshop antara Siswa yang 

Diajar dengan Metode Brainstorming dan Metode Tanya Jawab “maka perlu 

adanya penegasan istilah sebagai berikut : 

1.7.1 Penguasaan Konsep 

Menurut Bloom dalam Waluya (2008:4) menyatakan bahwa „Pemahaman 

konsep adalah kemampuan menangkap pengertian-pengertian seperti mampu 

mengungkapkan suatu materi yang disajikan ke dalam bentuk yang lebih 

dipahami, mampu memberikan interpretasi, dan mampu mengaplikasikannya‟. 
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1.7.2 Diajar 

Diajar yang dimaksud dalam penelitian ini adalah siswa diberikan 

pelajaran baik teori ataupun praktik dalam kaitannya sebagai seorang peserta 

didik. 

1.7.3 Photoshop 

Photoshop merupakan program standar yang digunakan dalam dunia 

imaging dan retouching foto.Dalam perkembangannya, program photoshop ini 

dapat digunakan juga dalam pembuatan web, khususnya desain web               

(Andi, 2005: 1). 

1.7.4 Metode Brainstorming 

Metode brainstorming adalah suatu teknik atau cara mengajar yang 

dilaksanakan oleh guru di dalam kelas dengan cara melontarkan suatu masalah ke 

kelas oleh guru, kemudian siswa menjawab atau menyatakan pendapat sehingga 

masalah tersebut berkembang menjadi masalah baru ( Roestiyah, 2012: 73). 

1.7.5 Metode Tanya Jawab 

Metode tanya jawab adalah suatu teknik untuk memberi motivasi pada 

siswa agar bangkit pemikirannya untuk bertanya, selama mendengarkan pelajaran 

atau guru yang mengajukan pertanyaan – pertanyaan itu, siswa menjawab              

( Roestiyah, 2012: 129). 
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1.8 Sistematika Penulisan Skripsi 

Skripsi ini terdiri atas tiga bagian yan masing-masing diuraikan sebagai 

berikut : 

1. Bagian Awal 

Pada bagian awal skripsi ini  berisi : halaman judul, halaman pengesahan, 

pernyataan, motto dan persembahan, kata pengantar, abstrak, daftar isi, daftar 

tabel, daftar gambar, dan daftar lampiran.  

2. Bagian Isi 

Bagian isi skripsi merupakan bagian pokok dalam skripsi yang terdiri dari 5 

bab, yaitu sebagai berikut : 

(1) Bab I terdiri dari : 

Pendahuluan berisi latar belakang, identifikasi masalah, pembatasan 

masalah, perumusan masalah, tujuan penelitian, manfaat penelitian, 

penegasan istilah, dan sistematika penulisan skripsi. 

(2) Bab II terdiri dari : 

Kajian pustaka berisi kajian teori, penelitian yang relevan, kerangka 

berpikir, dan hipotesis. 

(3) Bab III terdiri dari : 

Metode penelitian berisi model atau metode penelitian, populasi dan 

sampel, lokasi dan waktu penelitian, variabel penelitian, teknik 

pengumpulan data, instrument pengumpulan data dan teknik analisis data. 
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(4) Bab IV terdiri dari : 

Hasil penelitian dan pembahasan. 

(5) Bab V terdiri dari : 

Penutup berisi simpulan dan saran. 

3. Bagian Akhir 

Bagian akhir berisi daftar pustaka dan lampiran. 
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BAB II 

KAJIAN PUSTAKA 

 

2.1 Kajian Teori 

2.1.1 Pengertian Metode Mengajar 

Metode mengajar berasal dari dua kata yaitu metode dan mengajar, metode 

adalah suatu cara yang dipergunakan untuk mencapai tujuan yang telah ditetapkan 

(Djamarah, 1996: 53). Sedangkan Mengajar adalah suatu proses, yakni proses 

mengatur, mengorganisasi lingkungan yang ada di sekitar siswa sehingga dapat 

menumbuhkan dan mendorong siswa melakukan proses belajar                 

(Sudjana, 2013 :29).  

Menurut Sudjana (2013: 76) mengatakan, metode mengajar adalah cara 

yang dipergunakan guru dalam mengadakan hubungan dengan siswa pada saat 

berlangsungnya pengajaran. Dengan metode mengajar diharapkan tumbuh  

berbagai kegiatan belajar siswa sehubungan dengan kegiatan mengajar guru. 

Dengan kata lain terciptalah interaksi edukatif. 

Jadi dapat disimpulkan bahwa metode mengajar adalah cara yang 

digunakan guru dalam proses pembelajaran yang menciptakan interaksi edukatif 

antara guru dan siswa, suasana belajar dan pelajar yang memberi respon terhadap 

usaha guru tersebut sehingga tujuan pembelajaran dapat tercapai. Faktor yang 

mempengaruhi pemilihan metode mengajar : Penggunaan metode belajar harus 

dipilih dan digunakan dengan tepat agar dapat terjadi interaksi aktif dari warga 

belajar.  
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Menurut Winarno Surakhmad seperti dikutip Djamarah (1996: 88-93), 

banyak faktor yang mempengaruhi pemilihan metode mengajar diantaranya 

adalah sebagai berikut : 1) Tujuan dengan berbagai jenis dan fungsinya; 2) Anak 

didik dengan berbagai tingkat kematangannya; 3)  Situasi dengan berbagai 

keadaannya; 4) Fasilitas dengan berbagai kualitas dan kuantitasnya; 5) Pribadi 

guru serta kemampuan profesinya yang berbeda-beda. 

2.1.2 Metode Brainstorming 

2.1.2.1 Pengertian Metode Brainstorming 

Menurut Wulan dalam tulisannya pada jurnal pelita informatika budi 

darma mengatakan brainstorming adalah suatu teknik kreativitas kelompok 

dengan kelompok yang mencoba untuk mencari solusi untuk masalah yang 

spesifik dengan mengumpulkan daftar ide spontan disumbangkan oleh para 

anggotanya.Istilah ini dipopulerkan oleh Alex Osborn Faickney. 

Roestiyah dalam bukunya mengatakan, brainstorming adalah suatu 

teknik atau cara mengajar dengan melontarkan suatu masalah, kemudian siswa 

menjawab atau menyatakan pendapat sehingga mungkin masalah tersebut 

berkembang menjadi masalah baru atau dapat diartikan pula sebagai suatu cara 

untuk mendapatkan banyak ide dari sekelompok manusia dalam waktu yang 

sangat singkat (2012 :73-74). 

Maka dapat disimpulkan bahwa brainstorming atau curah gagasan 

adalah pemberian materi pelajaran dengan memperoleh pendapat atau ide-ide dari 

siswa dengan bebas tanpa seleksi yang akan menunjang daya pikir kreatifnya.  
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Siswa tidak hanya akan saling melengkapi gagasan-gagasan yang timbul, tetapi 

juga akan saling mengisi. 

2.1.2.2 Tujuan Metode Brainstorming 

Menurut Roestiyah, tujuan brainstorming adalah untuk menguras 

habis, apa yang dipikirkan para siswa dalam menangani masalah yang dilontarkan 

guru ke kelas tersebut (2012: 74). 

Sedangkan menurut Fentty dalam tulisannya pada jurnal skripsi 

mengatakan bahwa metode brainstorming digunakan untuk mengungkapkan apa 

yang ada dipikiran siswa dalam menanggapi dan memecahkan masalah yang 

dilontarkan oleh guru dikelas 

2.1.2.3 Langkah – langkah Metode Brainstorming 

Dalam metode ini guru bertugas memberikan masalah atau topik 

dikelas yang mampu merangsang siswa untuk menyampaikan gagasan, ide, serta 

tanggapan. Guru tidak boleh menanggapi, atau menyalahkan apa yang 

disampaikan oleh siswa. 

Roestiyah (dalam Dewi, 2014) langkah-langkah pembelajaran yang 

menggunakan metode brainstorming yaitu : 

(1) Pemberian informasi dan motivasi  

Guru menjelaskan masalah atau topik yang dihadapi beserta latar 

belakangnya dan mengajak peserta didik aktif untuk menyumbangkan 

pemikirannya. 
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(2) Identifikasi 

Pada tahap ini peserta didik diundang untuk memberikan sumbang saran 

pemikiran sebanyak-banyaknya.Semua saran yang masuk ditampung, ditulis dan 

tidak dikritik.Pimpinan kelompok dan peserta hanya boleh bertanya untuk 

meminta penjelasan.Hal ini agar kreativitas peserta didik tidak terhambat. 

(3) Klasifikasi 

Semua saran dan masukan peserta ditulis. Langkah selanjutnya 

mengklasifikasikan berdasarkan kriteria yang dibuat dan disepakati oleh 

kelompok. Klasifikasi bisa berdasarkan struktur atau faktor-faktor lain. 

(4) Verifikasi 

Kelompok secara bersama melihat kembali sumbang saran yang telah 

diklasifikasikan. Setiap sumbang saran diuji relevansinya dengan 

permasalahannya. Apabila terdapat sumbang saran yang sama diambil salah 

satunya dan sumbang saran yang tidak relevan bisa dicoret. Kepada pemberi 

sumbang saran bisa diminta argumentasinnya. 

(5) Konklusi ( Penyepakatan) 

Guru / pimpinan kelompok beserta peserta lain mencoba menyimpulkan 

butir-butir alternatif pemecahan masalah yang disetujui. Setelah semua puas, 

maka diambil kesepakatan terakhir cara pemecahan masalah yang dianggap paling 

tepat. 
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2.1.2.4 Kelebihan dan Kekurangan Metode Brainstorming 

Roestiyah dalam bukunya strategi belajar mengajar mengatakan 

bahwa teknik brainstorming memiliki banyak keunggulan dan kelemahan yang 

harus diatasi (2012 :74-75). 

(1) Metode Brainstorming dipakai karena memiliki beberapa kelebihan 

seperti: 

a. Anak-anak aktif berpikir untuk menyatakan pendapat. 

b. Melatih siswa berpikir dengan cepat dan tersusun logis. 

c. Merangsang siswa untuk selalu siap berpendapat yang berhubungan 

dengan masalah yang diberikan guru. 

d. Meningkatkan partisipasi siswa dalam menerima pelajaran. 

e. Siswa yang kurang aktif mendapat bantuan dari temannya yang pandai 

atau dari guru. 

f. Terjadi persaingan yang sehat. 

g. Anak-anak merasa bebas dan gembira. 

h. Suasana demokrasi dan disiplin ditumbuhkan. 

(2) Adapun kekurangan dari metode brainstorming yang perlu diatasi adalah : 

a. Guru kurang memberi waktu yang cukup kepada siswa untuk berpikir 

dengan baik. 

b. Anak-anak yang kurang selalu ketinggalan. 

c. Kadang-kadang berbicara hanya dimonopoli oleh anak yang pandai 

saja. 
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d. Guru hanya menampung pendapat tidak pernah merumuskan 

kesimpulan. 

e. Siswa tidak segera tahu apakah pendapatnya itu benar atau salah. 

f. Tidak menjamin pemecahan masalah. 

g. Masalah bisa berkembang kearah yang tidak diharapkan. 

2.1.3 Metode Tanya Jawab 

2.1.3.1 Pengertian Metode Tanya Jawab 

Metode tanya jawab adalah suatu teknik untuk memberi motivasi pada 

siswa agar bangkit pemikirannya untuk bertanya, selama mendengarkan pelajaran, 

atau guru mengajukan pertanyaan-pertanyaan itu, siswa menjawab         

(Roestiyah, 2012: 129). Selanjutnya menurut Roestiyah Tanya jawab dapat 

membantu tumbuhnya perhatian siswa terhadap pelajaran, serta mengembangkan 

kemampuannya untuk menggunakan pengetahuan dan pengalamannya, sehingga 

pengetahuannya menjadi fungsional (2012: 130). 

Sedangkan menurut Nana Sudjana metode tanya jawab adalah metode 

mengajar yang memungkinkan terjadinya komunikasi langsung yang bersifat two 

way traffic sebab pada saat yang sama terjadi dialog antara guru dan siswa            

(2013:78). Guru Bertanya siswa menjawab, atau siswa bertanya guru 

menjawab.Dalam komunikasi ini terlihat adanya hubungan timbal balik secara 

langsung antara guru dan siswa. 

Dari berbagai pendapat diatas maka dapat disimpulkan bahwa metode 

tanya jawab adalah cara penyajian pelajaran melalui berbagai bentuk pertanyaan 

dari atau kepada siswa, sehingga terjadi komunikasi langsung dua arah antara 
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guru dan murid. Metode ini dapat digunakan untuk meninjau ulang pelajaran yang 

telah disampaikan. 

2.1.3.2 Tujuan Metode Tanya Jawab 

Menurut Sudjana ,tujuan yang akan dicapai dari metode tanya jawab 

adalah : 

(1) Untuk mengetahui sejauh mana materi pelajaran yang telah dikuasi oleh 

siswa. 

(2) Untuk merangsang siswa berpikir. 

(3) Memberi kesempatan pada siswa untuk mengajukan masalah yang belum 

dipahami. 

Menurut Roestiyah penggunaan metode tanya jawab baik untuk 

maksud-maksud yang diperlukan untuk menyimpulkan atau mengikhtisarkan 

pelajaran atau apa yang dibaca, dengan dibantu tanya jawab siswa akan tersusun 

jalan pikirannya sehingga mencapai perumusan yang baik dan tepat, membantu 

tumbuhnya perhatian siswa pada pelajaran, meneliti kemampuan atau daya 

tangkap siswa untuk dapat memahami bacaan, dan mengetahui juga apakah siswa 

mendengarkan dengan baik (2012: 130). 

2.1.3.3 Jenis-Jenis Pertanyaan 

Menurut JJ. Hasibuan ( dalam Zulhani, 2014). Menggolongkan tiga 

jenis pertanyaan sebagai berikut : 

(1) Jenis-jenis pertanyaan menurut maksudnya : 

a. Pertanyaan permintaan (compliance question) 

b. Pertanyaan retorik ( rhetorical question) 
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c. Pertanyaan mengarah atau menuntun (prompting question) 

d. Pertanyaan menggali ( probing question)  

(2) Jenis-jenis pertanyaan menurut taksonomi Bloom 

a. Pertanyaan pengetahuan (recall question / knowledge question) 

b. Pertanyaan pemahaman (comprehension question) 

c. Pertanyaan penerapan (application question) 

d. Pertanyaan analisis (analysis question) 

e. Pertanyaan sintesis (synthesis question) 

f. Pertanyaan evalusi (evaluation question) 

(3) Jenis-jenis pertanyaan menurut luas sempitnya sasaran 

a. Pertanyaaan sempit (narrow question) 

b. Pertanyaan luas (broad question) 

2.1.3.4 Tahapan Metode Tanya Jawab 

Menurut Gintings (dalam Ika, 2013) dalam penggunaan suatu metode 

tentunya ada sistematika yang dapat digunakan untuk mempergunakaan metode 

tersebut. Adapun langkag-langkah yang ditawarkan dalam penggunaan metode 

tanya adalah sebagai berikut : 

(1) Pelajari topik atau sub-topik yang akan dipelajari oleh  siswa dan buat 

catatan tentang aspek atau isu utamanya. 

(2) Buat pertanyaan yang terkait dengan isu-isu utama dan catat dalam RPP. 

(3) Sampaikan tujuan pembelajaran yang diikuti dengan ikhtisar materi dan 

diselingi dengan mengajukan pertanyaan yang telah disiapkan sesuai 

dengan isu atau topik yang sedang diajarkan. 
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(4) Tanggapi jawaban siswa lain untuk memberikan komentar atau 

melengkapi jawaban siswa tersebut. 

(5) Buatlah rangkuman apapun papan tulis yang berisi jawaban dari semua 

pertanyaan yang telah dijawab. 

(6) Berikan tugas lanjutan yang harus dikerjakan siswa untuk memperkaya 

pemahamannya tentang topik yang sedang dibahas. 

2.1.3.5 Kelebihan dan Kekurangan Metode Tanya Jawab 

Menurut Roestiyah dalam pelaksanaan metode tanya jawab memiliki 

kelebihan dan kekurangan (2012: 132). 

(1) Adapun kelebihannya adalah : 

a. Kelas akan lebih hidup. 

b. Siswa tidak hanya mendengarkan ceramah saja. 

c. Partisipasi siswa lebih besar dan berusaha mendengarkan pertanyaan 

guru dengan baik dan mencoba untuk memberikan jawaban yang tepat. 

d. Siswa akan menerima pelajaran dengan aktif berpikir, tidak pasif 

mendengarkan saja. 

(2) Sedangkan kelemahan metode tanya jawab adalah : 

a. Kelancaran jalannya pelajaran agak terhambat karena diselingi tanya 

jawab. 

b. Jawaban siswa belum tentu selalu benar. 

c. Dapat menyimpang dari persoalannya. 

d. Guru memerlukan waktu lebih lama untuk memperoleh jawaban yang 

benar. 
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2.1.4 Penguasaan Konsep Photoshop 

2.1.4.1 Pengertian Penguasaan Konsep 

Menurut Oemar Hamalik dalam bukunya kurikulum dan pembelajaran  

( dalam Indah, 2009) “ Suatu konsep adalah suatu kelas atau kategori stimuli yang 

memiliki ciri-ciri umum. Stimuli merupakan objek-objek atau orang (person). 

Konsep-konsep  tidak terlalu kongruen dengan pengalaman pribadi kita tetapi 

menyajikan usaha-usaha manusia untuk mengklasifikasikan pengalaman kita. 

Konsep adalah suatu yang sangat luas”. Sedangkan menurut Winkel dalam buku 

psikologi pembelajaran : 

“ Konsep merupakan suatu abstraksi dari pemikiran (ide) yang 

merupakan generalisasi dari sesuatu yang khusus atau spesifik. 

Konsep dibedakan atas konsep konkret dan konsep yang 

didefinisikan.Konsep konkret adalah pengertian yang menunjuk pada 

aneka objek dalam lingkungan fisik.Sedangkan konsep yang 

didefinisikan adalah konsep yang mewakili realitas hidup, tetapi tidak 

langsung menunjuk pada realitas dalam lingkungan hidup fisik, 

karena realitas itu tidak berbeda”. 

 

Oleh karena itu konsep-konsep itu merupakan penyajian-penyajian 

internal dari sekelompok stimuli-stimuli, konsep-konsep itu tidak dapat diamati, 

konsep-konsep harus disimpulkan dari perilaku. Walaupun kita tidak dapat 

memberikan suatu definisi verbal dari suatu konsep, suatu definisi tidak 

mengungkapkan semua hubungan-hubungan antara konsep itu dengan konsep 

yang lain. 

Oemar Hamalik menyatakan bahwa hal-hal yang harus diperhatikan 

untuk mengetahui keberhasilan siswa memahami suatu konsep, yaitu: (1) dapat 

menyebutkan contoh konsep, (2) dapat menyatakan ciri-ciri konsep; (3) dapat 
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memilih dan membedakan antara contoh dari yang bukan konsep; (4) dapat 

memecahkan masalah yang berkenaan dengan konsep. 

Menurut Rosser yang dikutip Waluya (2008), dikatakan bahwa, 

konsep adalah suatu abstraksi yang mewakili satu kelas objek-objek, kejadian-

kejadian, kegiatan-kegiatan, atau  hubungan-hubungan yang mempunyai atribut-

atribut yang sama. 

Menurut Benyamin S. Bloom yang dikutip oleh Djaali (2008) yaitu 

telah mengembangkan “taksonomi” untuk domain kognitif. Taksonomi adalah 

metode untuk membuat urutan pemikiran dari tahap dasar kearah yang lebih tinggi 

dari kegiatan mental, dengan enam tahap sebagai berikut : 

(1) Pengetahuan ialah kemampuan untuk menghafal, mengingat, atau 

mengulangi informasi yang pernah diberikan. Contoh : sebutkan lima 

bagian utama kamera 35mm. 

(2) Pemahaman ialah kemampuan untuk menginterprestasi atau mengulang 

informasi dengan menggunakan bahasa sendiri. Contoh : uraikan 6 tahapan 

dalam mengisi film untuk kamera 35mm. 

(3) Aplikasi ialah kemampuan menggunakan informasi, teori, dan aturan pada 

situasi baru. Contoh: pilih ekspose 3 kamera untuk pengambilan gambar 

yang berbeda. 

(4) Analisis ialah kemampuan mengurai pemikiran yang kompleks, dan 

mengenai bagian-bagian serta hubungannya. Contoh : bandingkan cara 

kerja dua kamera 35 mm yang memiliki model yang berbeda. 
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(5) Sintesis ialah kemampuan mengumpulkan komponen yang sama guna 

membentuk satu pola pemikiran yang baru. Contoh : susunlah urutan 

fotografi untuk 6 objek. 

(6) Evaluasi ialah kemampuan membuat pemikiran berdasarkan kriteria yang 

telah ditetapkan. Contoh : buatlah penilaian terhadap kualitas slide yang 

dihasilkan dalam lomba, dengan 4 urutan penilaian.  

Menurut Bloom yang dikutip Waluya (2008) pemahaman 

didefinisikan sebagai kemampuan untuk menyerap arti dari materi atau bahan 

yang dipelajari. 

Berdasarkan pendapat para ahli dan uraian tentang penguasaan 

konsep, maka dapat disimpulkan  bahwa penguasaan konsep adalah pemahaman 

atau kesanggupan siswa dalam menyerap arti dari materi atau bahan yang 

dipelajari yang didasarkan pada pengalaman tertentu yang relevan yang dapat 

digeneralisasikan dan diukur melalui tingkat perkembangan kognitif siswa sesuai 

dengan klasifikasi Bloom. 

2.1.4.2 Pengertian Photoshop 

Photoshop merupakan program yang sangat handal, program ini juga 

merupakan program standar yang digunakan dalam dunia imaging dan retouching 

foto.Dalam perkembangannya, program photoshop ini dapat digunakan juga 

dalam pembuatan web, khususnya desain web.Antarmuka program ini terdiri dari 

area kerja, beberapa window atau jendela, dan juga perintah menu.Tiap jendela 

terdiri palet layer, palet layer style, palet action dan palet droplet. Gambar 

dibawah ini merupakan screen area dari Adobe Photoshop CS. 
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Keterangan : 

A. Menu Bar   

B. Option Bar   

C. Toolbox  

D. Active Image Area 

E. Palet 

2.1.4.3 Mengenal Layer 

Layer adalah unsur yang sangat vital di dalam photoshop, sebab 

dengan layer ini dapat membuat suatu komposisi gambar dengan mudah. Layer 

dapat diumpamakan sebagai lapisan-lapisan transparan yang saling bertumpuk 

membentuk suatu objek.Dengan kemampuan layer ini, photoshop menjadi 

aplikasi editing bitmap yang sangat bagus dan powerful. Pemahaman terhadap 

B 

C 

D 

 

E 

A 

Gambar 2.1 Screen Area 
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layer akan sangat membantu dalam mewujudkan suatu komposisi foto atau 

gambar yang diinginkan. 

2.1.4.4 Mengenal Layer Style 

 

 

 

 

 

 

 

 

 

 

Keterangan :  

A. Parameter dari style 

B. Jenis Style 

Di bawah ini adalah jenis – jenis style yang dapat digunakan ke dalam 

objek kerja, yaitu :Drop Shadow, Inner Shadow, Outer Glow, Inner Glow, Bevel 

And Emboss, Satin, Color Overlay, Gradient Overlay, Pattern Overlay, Stroke. 

 

 

 

B 

A 

Gambar  2.2 Kotak Dialog Layer Style 
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2.1.4.5 Sekilas Tentang Desain Web 

Struktur Halaman Web, terdiri dari header, isi dan footer. Sebagai 

ilustrasinya lihat gambar barikut ini : 

Header 

Di dalam header dapat dimasukkan logo, banner, motto, 

ataupun nama website. 

 

Content atau Isi 

Di dalam content ini dapat dimasukkan semua yang akan 

ditampilkan sebagai topik utama website. 

 

Footer 

Footer pada umumnya dapat berisi dengan informasi 

tambahan atau info yang menunjang website tersebut. 

Gambar  2.3 Struktur Halaman Web 

Berikut ini adalah cara membuat Website Dengan Efek. Aurora. Ada 2 

tahap pembuatan dalam membuat website ini, yaitu : Membuat Header, Membuat 

Lembar Content. 
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2.1.4.6 Membuat Header 

(1) Ubah warna background dengan warna  R .221 G. 206 B.146, seperti yang 

dicontohkan dalam kotak dialog  color picker berikut : 

 

Gambar  2.4 Kotak Dialog Color Picker 

(2) Buka file dokumen File > New, kemudian ketikkan angka 800 dan 250 

pada kotak isian Width dan Height dan 72 pada kotak isian Resolution. Klik Ok.  

 

Gambar 2.5 Kotak Dialog New 
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Gambar  2.6 Dokumen Baru 

(3) Setelah itu klik New layer, kemudian tekan tombol D pada papan keyboard 

untuk mereset warna  foreground dan background menjadi warna default. 

(4) Filter > Render > Clouds, sehingga akan seperti gambar dibawah ini : 

 

Gambar 2.7 Clouds 

(5) Ubah type blend dari normal menjadi Vivid Light pada drop down menu 

blend yang terletak pada ujung kiri atas pada palet layer,maka hasilnya seperti 

berikut ini : 

 

Gambar  2.8 Setelah Pemberian Blend Vivid Light 

Jika ingin mendapatkan warna sesuai keinginan , kita dapat menekan tombol Ctrl 

+ Fberulang kali hingga mendapatkan hasil yang maksimal. 

(6) Kemudian ubah warna foreground dengan warna hijau  R.0 G.96 B.0, klik 

OK. 

(7) Klik icon Brush Tool pada jendela Toolbox dan kuaskan pada gambar. 
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Gambar 2.9 Hasil Kuasan dengan Brush Tool 

(8) Pilih palet Brushes atau pilih window > Brushes atau tekan F5 pada 

keyboard . 

 

                   Gambar  2.10 Palet Brushes 

(9) Dan kuaskan pada gambar yang sudah kita buat . 

(10) Klik icon Text Tool dan ketikkan Aurora website. 

 

Gambar 2.11 Header Website 



28 

 

 

 

2.1.4.7 Membuat Lembar Content 

(1) Pilih menu Image > Canvas Size, ubah angka pada kotak isian  

Height : 250 menjadi 100 Pixel,seperti kotak dialog berikut. Jangan lupa untuk 

mengubah arah. 

 

 

 

 

 

 

 

 

(2) Untuk warna Canvas Extension Color pilih warna foreground yaitu hijau 

R.0 G.96 B.0. Maka akan menjadi dokumen Nada memanjang ke bawah seperti 

berikut ini. 

 

 

 

 

 

 

 

 

 

Gambar  2.12  Kotak Dialog Canvas Size 

Gambar  2.13 Dokumen Menjadi Lebih Panjang Kearah Bawah 
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(3) Klik icon New Layer  dan beri nama garis pembatas. 

(4) Ubah warna foreground dengan warna kuning R.252 G.232 B.5. 

(5) Ubah warna background menjadi warna cokelat R.252 G.232 B.5 , OK. 

(6) Klik icon Rectangular Marquee Tool dan buat seleksi seperti gambar 

berikut : 

 

Gambar  2.14 Seleksi Menggunakan Rectangular Marquee Tool 

(7) Tekan tombol Alt + Backspace untuk mengisi warna foreground  ke dalam 

area seleksi. kemudian klik icon Add a Layer Style dan pilih Bevel and Embos , 

sesuaikan dengan parameter Bevel and Emboss dibawah ini dan klik Ok. 

 

Gambar  2.15   Parameter Bevel and Emboss 
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(8) Duplikat layer garis pembatas dengan tekan Ctrl + J, sehingga hasilnya 

seperti gambar berikut ini : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(9) Klik Icon New Layer kemudian klik Rengtangular Marquee Tool. 

(10) Tekan tombol Ctrl + Backspace  untuk mengisi area seleksi dengan warna 

background. 

(11) Ubah opacity dari 100 % menjadi 65%. 

(12) Pilih menu Select > Deselect atau tekan Ctrl + D untuk menghilangkan 

seleksi. 

Gambar  2.16 Garis Pembatas Telah Terdapat Pada Lembar Website 
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                        Gambar  2.17 Lembar Content Sudah Jadi 

2.2 Penelitian yang Relevan 

Dari hasil penelitian yang relevan tentang brainstorming dan tanya jawab 

dalam pembelajaran yang dilakukan Novi Setia (2012) menunjukkan bahwa 

metode  brainstorming mempunyai pengaruh terhadap kemampuan berpikir kritis 

siswa. Variabel metode pembelajaran brainstorming memberikan kontribusi 

dalam peningkatan kemampuan berpikir kritis siswa. 

Hasil penelitian Dwi (2007), menunjukkan bahwa ada peningkatan 

kreatifitas mahasiswa secara signifikan setelah diberi perlakuan dengan model 

belajar brainstorming. Selanjutnya  menurut penelitian Fentty, menunjukkan 

adanya pengaruh yang signifikan antara metode brainstorming dan kecerdasan 

interpersonal  pada siswa remaja yang telah diterapkan  metode pembelajaran 

brainstorming. 
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Sedangkan hasil penelitian mengenai tanya jawab yang dilakukan oleh Ika  

(2013) telah membuktikan bahwa terjadi peningkatan keterampilan berbicara 

dengan penggunaan metode tanya jawab pada mata pelajaran bahasa Indonesia. 

Metode brainstorming dan tanya jawab dapat melatih keterampilan 

berbicara siswa karena metode brainstorming dan tanya jawab dapat melatih 

keberanian berpikir, menanamkan kepada pemahaman dan ingatan siswa untuk 

menguasai konsep yang diajarkan sehingga dapat memudahkan penguasaan 

konsep siswa dalam proses belajar mengajar. 

2.3 Kerangka Berpikir 

Dalam belajar, banyak sekali faktor yang mempengaruhinya.Salah satunya 

adalah pemilihan metode mengajar.Metode mengajar yang dipakai oleh guru 

sangat mempengaruhi metode belajar yang dipakai oleh siswa. Banyak sekali 

metode-metode mengajar yang diterapkan oleh guru dalam proses pembelajaran, 

diantaranya adalah metode brainstorming dan metode tanya jawab. 

Photoshop merupakan program standar yang digunakan dalam dunia 

imaging dan retouching foto.Dalam perkembangannya, program photoshop ini 

dapat digunakan juga dalam pembuatan web, khususnya desain web. Melalui mata 

pelajaran ini, peserta didik dikembangkan untuk lebih mengetahui dunia teknologi 

khususnya imaging. Dengan belajar photoshop diharapkan bermanfaat untuk 

peningkatan kualitas sumber daya manusia dibidang teknologi. 

Secara umum, tujuan pengajaran adalah pengetahuan yang disampaikan 

dapat dipahami oleh siswa.Dengan demikian, mengajar yang baik itu dapat terjadi 

jika terdapat peningkatan penguasaan konsep siswa. Hal itu dapat dipenuhi salah 
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satunya dengan penggunaan metode pembelajaran yang digunakan oleh guru yang 

menimbulkan perbedaan hasil belajar yang berarti bagi proses pembelajaran 

tersebut. 

Brainstorming  adalah salah satu metode pengajaran yang menekankan 

kepada siswa untuk berpikir kreatif dalam memecahkan suatu masalah. Salah satu 

tujuan metode ini adalah melatih siswa untuk mengekspresikan gagasan-gagasan 

baru menurut daya imajinasi mereka dan melatih daya kreativitas berpikir 

siswa.Salah satu kelemahan dari metode ini adalah kurangnya waktu yang 

diberikan untuk siswa memikirkan pemecahan masalah yang diberikan. 

Sedangkan metode tanya jawab adalah metode yang memungkinkan 

terjadinya komunikasi langsung antara guru dan siswa, sehingga guru dapat 

melakukan penilaian langsung sejauh mana perkembangan aspek kognitif, afektif 

dan psikomotorik siswa. Metode tanya jawab memiliki kelemahan diantaranya 

kemungkinan terjadi penyimpangan perhatian siswa bilamana terdapat pertanyaan 

atau jawaban yang tidak berkenaan dengan sasaran yang dibicarakan. 

Dalam metode brainstorming, siswa dituntut untuk berpikir kreatif dan 

logis terutama dalam usaha pemecahan masalah dari konsep yang diajarkan. 

Siswa dirangsang untuk mengemukakan pendapat sehingga mereka memperoleh 

pengalaman langsung dari daya pikir kreatifnya yang akibatnya akan 

meningkatkan siswa dalam menerima pelajaran. Dengan demikian, wajarlah bila 

mereka akan memiliki serta menyimpan konsep tersebut dengan lebih baik. 

Sedangkan dalam metode tanya jawab lebih mengedepankan aspek 

ingatan, selain itu terkadang siswa merasa takut untuk memberikan jawaban atau 
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bahkan untuk bertanya yang akibatnya siswa yang kurang menguasai konsep akan 

tertinggal. Dengan demikian metode brainstorming diharapkan dapat lebih 

meningkatkan penguasaan konsep siswa dibandingkan dengan metode tanya 

jawab. 

Berdasarkan teori maupun pendapat mengenai metode belajar 

brainstorming, metode tanya jawab dan penguasaan konsep, maka dapat 

dikatakan bahwa dalam belajar khususnya mata pelajaran photoshop diperlukan 

penggunaan metode belajar yang tepat. Salah satu cara untuk memilih metode 

yang tepat adalah dengan membandingkan metode yang ada terhadap peningkatan 

penguasaan konsep yang diperoleh siswa. 

Metode brainstorming dan metode tanya jawab dapat digunakan dalam 

upaya pencapaian penguasaan konsep siswa yang dapat diukur melalui 3 ranah 

yaitu kognitif, afektif, dan psikomotor. Selain itu juga diharapakan dapat menjadi 

salah satu metode yang menyenangkan dan membawa peserta didik keranah 

pembelajaran yang kreatif serta hasil pembelajaran yang optimal. 

Pada kegiatanbrainstorming  siswa berperan aktif untuk mengemukakan 

pendapatnya dari konsep yang telah mereka pelajari sebelumnya, metode ini 

merangsang siswa untuk berpikir kreatif dengan aktifnya siswa dalam kegiatan 

brainstorming dan tanya jawab maka pembelajaran akan lebih bermakna sehingga 

diharapkan akan terdapat perbedaan penguasaan konsep siswa yang menggunakan 

metode brainstorming  dengan metode tanya jawab. Penguasaan konsep siswa 

yang menggunakan metode brainstorming lebih tinggi dibandingkan penguasaan 

konsep siswa yang menggunakan metode tanya jawab. 
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2.4 Hipotesis 

Berdasarkan kerangka pikir yang telah dikemukakan sebelumnya, maka 

hipotesis yang dapat dirumuskan dalam penelitian ini adalah: 

Ho :    Tidak terdapat perbedaan penguasaan konsep photoshop  yang diajar 

dengan metode brainstorming dan metode tanya jawab. 

Ha : Terdapat perbedaan perbedaan penguasaan konsep photoshop yang 

diajar dengan metode brainstorming dan metode tanya jawab. 

Penguasaan konsep siswa yang menggunakan metode brainstorming 

lebih tinggi dibandingkan dengan penguasaan konsep siswa yang 

menggunakan metode tanya jawab. 

Adapun pengajuan hipotesis struktural yang digunakan adalah sebagai berikut:  

Ho : µA = µB 

Ha : µA > µB 

Keterangan  : 

µA =Rata – rata pengusaan konsep photoshop dengan metode        

brainstorming. 

µB  = Rata – rata penguasaan konsep photoshop dengan metode tanya 

jawab 

Apabila µA > µB maka Ho ditolak dan Ha diterima, yang berarti hipotesis 

diterima.  
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BAB III 

METODE PENELITIAN 

 

3.1 Model atau Metode  Penelitian 

Metode yang digunakan dalam penelitian ini adalah pendekatan kuantitatif 

yaitu metode penelitian yang berlandaskan pada filsafat positivisme, digunakan 

untuk meneliti pada populasi atau sampel tertentu, teknik pengambilan sampel 

pada umumnya dilakukan secara random, pengumpulan data menggunakan 

instrumen penelitian, analisis data bersifat kuantitatif/statistik dengan tujuan untuk 

menguji hipotesis yang telah ditetapkan ( Sugiyono, 2013:14). Jenis Penelitian 

yang dilakukan adalah quasi experiment( eksperimen semu), karena kelompok-

kelompok yang terpilih masih dapat berhubungan dan berada pada keadaan apa 

adanya. 

Perlakuan/treatment dilakukan pada dua kelompok, terhadap keduanya 

diberi tes awal ( pre test), kemudain kelompok A diberi pengajaran dengan 

metode  tanya jawab dan kelompok B diberi pengajaran dengan metode 

brainstorming. Setelah itu diberi tes akhir ( post test ). Hasil dari tes awal dan tes 

akhir masing-masing kelompok diperbandingkan. Desain yang digunakan adalah 

pre test post control group design. Desain penelitian dapat divisualisasikan 

sebagai berikut : 
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Tabel 3.1 Desain Penelitian 

Kelompok Pre Test Perlakuan Post Test 

A          

B          

Keterangan : 

   :  adalah tes awal pada kelompok A 

   :  adalah tes awal pada kelompok B  

   :  kelompok yang diberi perlakuan metode tanya jawab 

   :  kelompok yang diberi perlakuan metode brainstorming 

   :  tes akhir pada kelompok A 

   :  tes akhir pada kelompok B 

3.2 Populasi dan Sampel 

3.2.1 Populasi 

Populasi adalah wilayah generalisasi yang terdiri atas: objek / subjek yang 

mempunyai kualitas dan karakteristik tertentu yang ditetapkan peneliti untuk 

dipelajari dan kemudian ditarik kesimpulannya (Sugiyono, 2013: 117). Populasi 

dalam penelitian ini adalah siswa – siswi  jurusan rekayasa perangkat lunak           

( RPL) di SMKN 10 Semarang. . 

3.2.2 Sampel 

Sampel adalah bagian dari jumlah dan karakteristik yang dimiliki oleh 

populasi tersebut ( Sugiyono, 2013: 118). Teknik pengambilan sampelnya adalah 

Simple Random Sampling, karena penggambilan anggota sampel dari populasi 

dilakukan secara acak tanpa memperhatikan strata yang ada dalam populasi. 
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2 kelas diberikan tes kognitif tentang penelitian yang akan dilakukan 

kemudian diuji dengan uji “t” test. Jika hasil tidak berbeda atau sama maka kelas 

bisa ditentukan. Sampel pada penelitian ini adalah kelas X RPL I sebagai kelas 

kontrol dan X RPL II sebagai kelas eksperimen di SMKN 10 

Semarang.Perhitungan uji “t” test 2 kelas dapat dilihat pada lampiran 9. 

3.3 Lokasi dan Waktu Penelitian 

Penelitian ini dilaksanakan pada bulan April sampai dengan Mei 

2015.Sedangkan sekolah yang menjadi tempat penelitian adalah SMKN 10 

Semarang. 

3.4 Variabel Penelitian 

Dalam setiap penelitian, maka ada yang menjadi variabel.Variabel adalah 

konsep yang mempunyai bermacam-macam nilai. Pada penelitian ini terdapat dua 

variabel penelitian : 

3.4.1 Variabel Bebas 

Variabel bebas adalah variabel yang mempengaruhi atau yang menjadi 

penyebab dan nilai-nilainya tidak tergantung pada variabel lain. Variabel bebas 

dalam penelitian iniada dua yakni metode pembelajaran brainstorming dan 

metode pembelajaran tanya jawab. 

3.4.2 Variabel Terikat 

Variabel terikat adalah variabel yang menjadi akibat dari suatu penyebab 

dan nilai-nilainya bergantung pada variabel lain. Variabel terikat yang dimaksud 

dalam penelitian ini yaitu penguasaan konsep photoshop. 
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3.5 Teknik Pengumpulan Data 

Penelitian ini menggunakan teknik pengumpulan data sebagai berikut: 

(1) Penelitian kepustakaan, yaitu dengan mengadakan kajian terhadap buku-

buku serta hasil penelitian yang berhubungan dengan masalah yang 

dibahas. 

(2) Penelitian lapangan, yaitu dengan memberi soal photoshop untuk jurusan 

rekayasa perangkat lunak di SMKN 10 Semarang dengan tes objektif 

pilihan ganda dengan pokok bahasan membuat desain template website 

dengan photoshop. Dilakukan untuk mengetahui hasil penguasaan konsep 

sebagai variabel yang akan diteliti.    

3.6 Instrumen Pengumpulan Data 

Instrumen penelitian adalah suatu alat yang digunakan mengukur 

fenomena alam maupun sosial yang diamati (Sugiyono, 2013: 148). Dan 

selanjutnya dijadikan alat bantu didalam metode pengumpulan data. 

Instrumen yang digunakan dalam penelitian ini adalah tes sebelum dan 

sesudah penerapan pengajaran dengan metode brainstorming dan metode tanya 

jawab pada kedua kelas eksperimen. Tes yang digunakan adalah tes objektif  

dengan 4 alternatif jawaban. Dalam penelitian ini dilakukan beberapa langkah 

dalam penyusunan instrumen yaitu : 

3.6.1 Penyusunan Soal 

Penyusunan soal untuk menentukan penguasaan konsep. Soal dalam 

bentuk objektif ( pilihan ganda) dengan jumlah option sebanyak 4 option yaitu a, 
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b, c dan d dengan pokok bahasan membuat desain templatewebsite dengan 

photoshop. 

Pada penelitian ini, ranah yang diukur adalah ranah kognitif yang meliputi 

aspek ingatan, pemahaman, aplikasi, analisis, sintesis dan evaluasi. Untuk tes 

objektif (pilihan ganda) dalam pemberian skor akan mendapatkan nilai 1 jika 

benar dan 0 jika salah.  

3.6.2 Uji Coba 

Soal yang telah dibuat akan diujicobakan pada kelas XI RPL I yaitu siswa 

diluar objek penelitian. 32 siswa sebagai sampel acak dengan mengerjakan tes 

sebanyak 50 soal pilihan ganda, agar dapat diketahui validitas, reliabilitas, daya 

pembeda dan tingkat kesukarannya. 

3.6.2.1 Uji Validitas 

Validitas berasal dari kata validity yang mempunyai arti sejauhmana 

akurasi suatu tes atau skala dalam menjalankan fungsi pengukurannya        

(Azwar, 2014: 8). Pengukuran dikatakan mempunyai validitas yang tinggi apabila 

menghasilkan data yang secara akurat memberikan gambaran mengenai variabel  

yang diukur seperti dikehendaki oleh tujuan pengukuran tersebut. Akurat dalam 

hal ini berarti tepat dan cermat sehingga apabila tes menghasilkan data yang tidak 

relevan dengan tujuan pengukuran maka dikatakan sebagai pengukuran yang 

memiliki validitas rendah. 

Validitas yang diukur dalam penelitian ini adalah validitas isi.Tes 

dikatakan memiliki validitas isi apabila mengukur tujuan khusus tertentu yang 

sejajar dengan materi atau isi pelajaran yang diberikan (Suharsimi Arikunto, 2013: 
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82). Rumus yang digunakan adalah rumus yang dikemukakan oleh Pearson, yang 

dikenal dengan rumus korelasi product moment( Arikunto, 2013:87). 

    
 ∑   (∑ )(∑ )

√* ∑   (∑ ) +* ∑   (∑ ) +
 

Keterangan : 

     : koefisien antara x dan y 

   : banyaknya subjek yang diteliti 

∑   :jumlah skor tiap butir soal 

∑   : jumlah skor total 

∑    : jumlah kali skor tiap butir soal dengan skor total    

∑    : jumlah kuadrat skor butir soal 

∑    : jumlah kuadrat skor total 

Setelah didapat harga     kemudian dibandingkan dengan        yang taraf 

signifikan 5 %. Jika    >        ,maka butir soal tersebut dikatakan valid. 

Instrumen telah diuji cobakan pada kelas uji coba yaitu kelas XI RPL 1 dan 

diperoleh         dengan N = 32 dan taraf  signifikan 5% adalah 0,296. Hasil 

perhitungan validitas dapat dilihat pada lampiran 5. 

Tabel  3.2 Hasil Uji Validitas Soal Uji Coba 

Uji Validitas Nomor Soal Jumlah Soal 

Valid 

2, 3, 4, 6, 7, 8, 10, 12, 13, 14, 15, 16, 18, 19, 21, 

23, 24, 25, 26, 29, 30, 31, 34, 37, 38, 40, 43, 44, 

47, 48, 49 

31 

Tidak Valid 
1, 5, 9, 11, 17, 20, 22,  27, 28, 32, 33, 35, 36, 39, 

41, 42, 45, 46, 50 

19 

Jumlah 50 
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3.6.2.2 Uji Reliabilitas 

Reliabilitas adalah ketetapan suatu tes apabila diteskan kepada subjek 

yang sama ( Suharsimi Arikunto, 2013: 104). Untuk mengetahui ketetapan ini 

pada dasarnya dilihat kesejajaran hasil. 

Sehubungan dengan reliabilitas ini, scarvia B. Anderson dan kawan-

kawan menyatakan bahwa persyaratan bagi tes, yaitu validitas dan realibilitas ini 

penting.Dalam hal ini, validitas lebih penting dan reliabilitas ini perlu, karena 

menyokong terbentuknya validitas.Sebuah tes mungkin reliabel tetapi tidak 

valid.Sebaliknya, sebuah tes yang valid biasanya reliabel. Untuk menentukan 

reliabilitas instrumen digunakan rumus Kuder-Richardson (KR-20), yaitu : 

 
    (

 

   
)(
   ∑  

  
)
 

Keterangan : 

    : reliabilitas  tes secara keseluruhan 

  : proporsi subjek yang menjawab item dengan benar 

  :proporsisubjek yang menjawab item dengan salah 

∑   : jumlah hasil perkalian antara p dan q 

  : banyaknya item 

  : standar deviasi dari tes  

( standar deviasi adalah  akar varians). 

Setelah didapatkan hasil, maka ditentukan nilai reliabilitas dengan 

mengkonsultasikan pada koefisien reliabilitas tes sebagai berikut : 
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Tabel  3.3 Indeks Reliabilitas 

 

 

 

Dari hasil uji coba yang telah dilaksanakan telah diketahui tingkat 

reliabilitas dari soal tersebut yaitu 0,91. Nilai tersebut telah memenuhi syarat 

reliabilitas yang sangat tinggi.Contoh perhitungan realibilitas dapat dilihat pada 

lampiran 6. 

3.6.2.3 Uji Tingkat Kesukaran 

Cara menggunakan tingkat kesukaran soal dengan menggunakan 

rumus : 

  
 

  
  (Suharsimi Arikunto, 2013: 223) 

Keterangan : 

P   : tingkat kesukaran soal 

B  : banyaknya siswa yang menjawab soal itu dengan benar 

Js  : jumlah seluruh siswa peserta tes 

Menurut ketentuan yang sering diakui, indeks kesukaran sering 

diklasifikasikan sebagai berikut : 

Tabel 3.4 Kriteria Indeks Kesukaran Soal 

Interval P Kriteria 

0,00 - 0,30 

0,30 - 0,70 

0,70 - 1,00 

Sukar 

Sedang 

Mudah 

Interval  Kriteria 

0,91 – 1,00 

0,71 – 0,90 

0,41 – 0,40 

0,21 – 0,40 

< 0,20 

Sangat tinggi 

Tinggi 

Cukup 

Rendah 

Sangat rendah 
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Hasil analisis taraf kesukaran pada soal uji coba dapat dilihat 

padatabel 3.5.Contoh perhitungan tingkat kesukaran dapat dilihat pada lampiran 7. 

Tabel 3.5 Hasil Taraf Kesukaran Soal Uji Coba 

Taraf 

kesukaran 
Nomor Soal 

Jumlah 

Soal 

Mudah 1,5,8,12,17,20,22,25,28,30,33,36,37,38,39,41,42,45 19 

Sedang 2,3,6,7,10,11,13,18,19,21,23,26,27,31,43,44,46,47,48,49,50 21 

Sukar 4,9,14,15,16,24,29,31,34,40 10 

Jumlah 50 

 

3.6.2.4 Uji Daya Pembeda 

Daya pembeda adalah kemampuan soal untuk membedakan antara 

siswa yang berkemampuan tinggi dengan siswa yang berkemampuan rendah. 

   
  

  
 
  

  
  ( Suharsimi Arikunto, 2013: 226) 

Keterangan : 

DP : daya pembeda soal 

   : jumlah jawaban benar dari kelompok atas 

   : jumlah jawaban benar dari kelompok bawah 

JA : jumlah siswa pada kelompok atas 

JB : jumlah siswa pada kelompok bawah   

Tabel 3.6 Kriteria Daya Pembeda Soal 

 

 

 

Interval  Kriteria 

0,00 < D ≤ 0,20 

0,21 ≤ DP ≤ 0,40 

0,41 < DP ≤ 0,70 

0,71 < DP ≤ 1,00 

Jelek 

Cukup 

Baik 

Sangat baik 
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Hasil analisis daya pembeda pada soal uji coba dapat dilihat pada 

tabel 3.7.Contoh perhitungan daya pembeda  dapat dilihat pada lampiran 8. 

Tabel 3.7 Hasil Daya Pembeda Soal Uji Coba 

Uji Validitas Nomor Soal Jumlah  

Jelek 1, 5,9,11,14,17,20,22,27,28,32,33,35,36,39,41,42,45,46,50 20 

Cukup 4,8,16,18,21,25,26,34,37,38,40,49 12 

Baik 3,12,13,15,19,23,24,29,30,31,44,48 12 

Baik Sekali 2,6,7,10,43,47 6 

Jumlah  

Berdasarkan analisis di atas, soal yang digunakan dalam penelitian 

ini adalah soal yang dinyatakan valid, reliabel, dan mempunyai daya pembeda 

dengan kriteria cukup dan baik. 

3.7 Teknik Analisis Data 

3.7.1 Uji Awal 

Analisis data yang digunakan meliputi uji normalitas dan uji homogenitas. 

Secara rinci dijabarkan sebagai berikut : 

(1) Uji Normalitas 

Untuk uji normalitas, analisis data dilakukan dengan menggunakan uji 

normalitas chi kuadrat ( x² ). Uji normalitas dilakukan untuk mengetahui apakah 

data yang diperoleh berasal dari populasi distribusi normal atau tidak. Adapun 

kriterianya sebagai berikut : 

x²  hitung  < x² table    = Data berdistribusi normal 

x² hitung  > x² table     = Data berdistribusi tidak normal 
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Adapun rumus chi kuadrat untuk uji normalitas adalah : 

    ∑ (
     

  
) 

   ² ( Sudjana, 2005:  273) 

Keterangan : 

   : chi kuadrat 

   : frekuensi yang diperoleh dari data penelitian 

   : frekuensi yang diharapkan 

  : banyaknya kelas interval 

(2) Uji Homogenitas 

Untuk uji homogenitas, analisa data dilakukan dengan menguji 

homogenitas dua varians.Uji homogenitas dilakukan untuk mengetahui apakah 

data yang diperoleh homogen atau tidak, terhadap dua kelompok perlakuan. 

Adapun kriterianya sebagai berikut : 

- F hitung < F table              = Variabel data homogen 

- F hitung > F table          = Variabel data tidak homogen 

Adapun rumusnya sebagai berikut : 

  
                

                
 

3.7.2 Analisis Data 

Data yang didapat yaitu dari hasil belajar masing-masing sampel 

berdasarkan tes yang dilakukan akan diuji hipotesis dengan uji “t”. Uji  beda     

rata – rata berfungsi untuk mengetahui apakah penguasaan konsep photoshop  

siswa kelas eksperimen lebih baik daripada kelas kontrol, jika data berdistribusi 
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normal dan homogen maka uji yang digunakan adalah uji “t” pihak kanan. 

Adapun dihoptesis yang digunakan adalah : 

Ho : µ1 < µ2 ( kemampuan penguasaan konsep photoshop  siswa dengan metode                                                         

pembelajaran brainstorming kurang dari atau sama dengan  

kemampuan penguasaan konsep photoshop  siswa dengan metode 

pembelajaran tanya jawab). 

Ha : µ1 > µ2 (kemampuan penguasaan konsep photoshop  siswa dengan metode                                                         

pembelajaran brainstorming lebih dari kemampuan penguasaan 

konsep photoshop  siswa dengan metode pembelajaran tanya 

jawab). 

Rumus uji “t” adalah sebagai berikut : 

         
      

 √
 

  
  

 

  

 

Dengan 

  √
(    )    (    )   

           
 

(Sudjana, 2005: 239) 

Keterangan : 

        : nilai  hitung 

    : rata – rata hasil tes kelas eksperimen 

    : rata – rata hasil tes kelas kontrol 

    : banyaknya subjek kelas eksperimen 

    : banyaknya subjek kelas kontrol 
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     : varians kelas eksperimen 

     : varians kelas kontrol 

   : simpangan baku gabungan 

Kriteria pengujian adalah Ho diterima jika 

       < (   )(       )        . Diperoleh dari table distribusi t dengan taraf 

nyata 5% dan dk = (1- a)(n1+  n2 - 2). Ho ditolak untuk t yang lain (Sudjana, 

2005:243). 

3.7.3 Analisis Peningkatan Hasil Belajar Siswa 

Peningkatan hasil belajar siswa dihitung menggunakan rumus modifikasi 

gain rata-rata ternormalisasi, pretest, posttest, yang dikembangkan oleh 

Savinainen dan Scott (Wiyanto, 2008).Berikut N-gain dengan kriterianya 

disajikan pada tabel 3.8. 

    
  ̅          ̅        

       ̅        
 

Tabel 3.8 Tabel Kriteria Penilaian Peningkatan Hasil Belajar 

N-Gain Kriteria 

g > 0,7 Tinggi 

0,3 < g ≤ 0,7 Sedang 

g ≤ 0,3 Rendah 

Rata-rata nilai pretest dan posttest dibuat dalam presentase. Apabila hasil 

analisis kurang dari sama dengan 0,3 artinya data mengalami peningkatan rendah. 

Sedangkan bila hasil analisis berada di antara angka 0,3 dan sama dengan 0,7 

berarti data mengalami peningkatan sedang. Selanjutnya data mengalami 

peningkatan tinggi apabila hasil analisis lebih dari 0,7.  
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BAB IV 

HASIL PENELITIAN DAN PEMBAHASAN 

 

4.1 Hasil Penelitian 

Penelitian dilaksanakan pada bulan Mei sampai Juni 2015 di SMKN 10 

Semarang.Sampel dalam penelitian ini terbagi dalam 2 kelompok, yaitu kelas X 

RPL I sebagai kelas kontrol dan X RPL II sebagai kelas eksperimen. Dalam 

proses pembelajaran photoshop. Kelas eksperimen diberikan perlakuan metode 

brainstorming dan kelas kontrol diberi perlakuan metode tanya jawab. Kemudian 

kedua kelas diberi tes pilihan ganda (pilgan) untuk mengukur pemahaman konsep 

siswa terhadap materi photoshop. Adapun hasil penelitian yang diperoleh, 

diuraikan sebagai berikut: 

4.2 Analisis Hasil Pretest 

Pada uji hasil pretest menggunakan uji t-test dua pihak bertujuan untuk  

menguji perbedaan dua rata-rata kelompok sampel. Rekapitulasi hasil uji t-test 

pretest data hasil belajar siswa dapat dilihat pada lampiran tabel dibawah ini : 

Tabel 4.1 Hasil uji “t” Pretest 

Kelompok                 Kriteria 

Eksperimen 

0,925 1,998 

Tidak Berbeda 

Signifikan Kontrol 

 

Berdasarkan  hasil analisis data diperoleh         = 0,925 sedangkan        = 

1,998 jadi        <       karena         berada pada daerah penerimaan Ho, maka 
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dapat disimpulkan bahwa tidak ada perbedaan yang signifikan antara kedua 

kelompok. Perhitungan uji “t” pretest data hasil belajar kelompok kontrol dan 

kelompok eksperimen dapat dilihat pada lampiran 9. 

4.3 Analisis Hasil Postest 

4.3.1 Uji Normalitas 

Untuk  mengetahui data akhir berdistribusi normal, tes yang digunakan adalah chi 

kuadrat pada taraf signifikan 5%. 

Hipotesis yang digunakan : 

Ho : distribusi data akhir berdistribusi normal 

Ha : distribusi data akhir tidak  berdistribusi normal.  

A. Uji Normalitas Data Akhir Kelas Eksperimen 

Berdasarkan hasil perhitungan posttest pada kelas eksperimen diperoleh data 

sebagai berikut : 

Tabel 4.2 Deskripsi Posttest Brainstorming 

Deskripsi Nilai 

Nilai maksimum 93 

Nilai minimum 60 

Rentang 33 

Banyak kelas 6 

Panjang kelas 5,6  6 

Rata – rata 80,00 

Banyak data 33 

Simpangan baku 7,55 
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Sehingga diperoleh          = 6,6539. Harga ini dikonsultasikan dengan taraf 

signifikan 5% dengan dk = 6 – 3 = 3 diperoleh         =  (    ) ( ) = 7,81. Karena 

        <         maka Ho diterima. Jadi distribusi data akhir  kelas eksperimen 

berdistribusi  normal. 

B. Uji Normalitas Data Akhir Kelas Kontrol 

Berdasarkan hasil perhitungan posttest pada kelas kontrol diperoleh data 

sebagai berikut : 

Tabel 4.3 Deskripsi Posttest Tanya Jawab 

Deskripsi Nilai 

Nilai maksimum 80 

Nilai minimum 60 

Rentang 20 

Banyak kelas 6 

Panjang kelas 3,4  4 

Rata – rata 69,24 

Banyak data 33 

Simpangan baku 5,67 

 

Sehingga diperoleh          = 6,5201.         =  (    ) ( ) = 7,81. Karena 

        <         maka Ho diterima. Jadi distribusi data akhir  kelas kontrol 

berdistribusi  normal. Rekapitulasi hasil uji normalitas data hasil belajar siswa 

dapat dilihat pada tabel 4.4. 
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Tabel 4.4 Hasil Uji Normalitas Data Hasil Belajar 

Kelompok        
        

  Kriteria 

Eksperimen 6,65 
7,81 Normal 

Kontrol 6,52 

 

Berdasarkan hasil analisis data diperoleh         
 <      

  dengan taraf 

signifikan   = 5 %, maka dapat disimpulkan bahwa data tersebut bedistribusi 

normal. Perhitungan uji normalitas data hasil belajar kelompok kontrol dan 

kelompok eksperimen dapat dilihat pada lampiran 15 dan 16. 

4.3.2 Uji Homogenitas 

Untuk mengetahui apakah varians dari data sama atau tidak maka 

dilakukan uji homogenitas. 

Hipotesis yang digunakan: 

Ho :     =    ( data akhir tes penguasaan konsep photoshop kelas eksperimen  

dan kelas kontrol mempunyai varians yang sama). 

Ha :     =      (data akhir tes penguasaan konsep photoshop kelas eksperimen 

                              Dan kelas kontrol mempunyai varians yang tidak sama). 

Tabel 4.5 Hasil Uji Homogenitas Data Hasil Belajar 

Kelompok Varians dk F Hitung F Tabel 
Kriteria 

Eksperimen 56,944 32 
1,769 2,025 Homogen 

Kontrol 32,189 32 
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Berdasarkan hasil perhitungan diperoleh varians kelas eksperimen = 

56,944 dan varians kelas kontrol = 32,189. Sehingga diperoleh         = 1,769. 

Untuk    pembilang = nb – 1= 33 – 1 = 32,    penyebut = nk – 1 = 33 – 1 = 32, 

dan dengan peluang 
 

 
  (     ) diperoleh        =    (     )(     ) = 2,025. 

Karena         <  
 
  (    ) (    )

maka Ho diterima. Jadi data akhir kelas 

eksperimen dan kelas kontrol mempunyai varians yang sama. Perhitungan uji 

homogenitas data hasil belajar kelompok kontrol dan kelompok eksperimen dapat 

dilihat pada lampiran 17. 

4.3.3 Pengujian Hipotesis 

Setelah melakukan pengujian prasyarat analisis (normalitas dan 

homogenitas), diketahui bahwa kedua kelompok berdistribusi normal dan 

homogen. Karena kedua kelompok bersifat normal dan homogen  maka hipotesis  

penelitian diuji dengan menggunakan “t” test. “t” test yang dilakukan adalah 

untuk mengetahui perbedaan  metode pembelajaran Brainstorming dan metode 

tanya jawab terhadap penguasaan konsep photoshop dengan membandingkan 

hasil pretest dan posttest. 

Dari hasil perhitungan diperoleh t hitung untuk membandingkan pretest 

dan posttest kelompok Brainstorming sebesar 5,333. Sedangkan t hitung untuk 

membandingkan pretest dan posttest  kelompoktanya jawabsebesar 4,969. Dengan 

db sebesar 32 dan taraf signifikan 0,05 maka t tabel diperoleh sebesar 2,025. 

Karena        >       maka dapat disimpulkan terdapat peningkatan penguasaan 

konsep photoshop  sebelum dan sesudah pembelajaran dilaksanakan pada kedua 
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kelompok. Contoh perhitungan uji “t” test kelompok kontrol dan eksperimen 

dapat dilihat pada lampiran 13 dan 14. 

Pengujian hipotesis selanjutnya adalah membandingkan hasil posttest  

kedua kelompok. Berdasarkan uji “t” test  diketahui       >      , untuk posttest 

kedua kelompok. Karena t hitung sebesar 6,5456 sedangkan taraf signifikan 0,05 

dengan derajat kebebasan (dk) =64 (33+33-2) maka didapat  harga t tabel sebesar 

1,998. Karena        >       maka hipotesis penelitian (Ha) diterima dan 

hipotesis nol (H0) ditolak. Sehingga dapat diambil kesimpulan bahwa terdapat 

perbedaan yang signifikan antara penguasaan konsep photoshop yang 

menggunakan metode brainstorming dan metode tanya jawab. Contoh 

perhitungan pengujian hipotesis dapat dilihat pada lampiran 18. 

Tabel 4.6 Pengujian Hipotesis dengan “t” test 

Kelompok Jumlah Df X                Keputusan 

Brainstorming 

Tanya Jawab 

33 

33 

64 80,000 

 

69,242 

6,5456 

 

1,998 

 

Ha Diterima 

 

4.3.4 Interpretasi Hasil Pengujian Hipotesis 

Dari perhitungan hasil uji normalitas dan homogenitas dari kelompok 

brainstorming dan kelompok tanya jawab dapat disimpulkan bahwa kedua sampel 

tersebut dalam sebaran yang normal dan homogen. Uji normalitas diperlukan 

peneliti untuk melihat penyebaran data, sedangkan uji homogenitas diperlukan 

untuk beberapa sampel, yakni seragam tidaknya variabel sampel-sampel yang 

diambil dari populasi yang sama. 
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Dari hasil perhitungan gain diketahui  bahwa peningkatan penguasaan 

konsep photoshop siswa pretest dan posttest kelompok eksperimen yang 

menggunakan metode brainstorming sebesar 5,333 dan kelompok kontrol yang 

menggunakan metode tanya jawab sebesar 4,969. Setelah dibandingkan dengan 

jumlah siswa masing-masing kelompok yaitu 33, maka db = 32 sehingga t tabel 

diperoleh sebesar 2,025. Dengan demikian dapat disimpulkan adanya peningkatan 

yang signifikan antara  pretestdan posttest masing-masing kelompok, namun hal 

tersebut belum dapat membuktikan adanya perbedaan penguasaan konsep 

photoshop pada siswa. 

Kemudian perbedaan dianalisis dengan menggunakan uji “t” test. Dari 

hasil perhitungan didapat harga         sebesar 6,5456 dan        sebesar 1,998. 

Setelah harga         dibandingkan dengan harga        pada taraf signifikan 5% 

maka dapat diketahui        >      , (6,5456 > 1,998), sehingga dapat 

disimpulkan bahwa hipotesis penelitian (Ha) diterima dan hipotesis nol (H0) 

ditolak. 

Dengan ditolaknya hipotesis nol (H0) dan diterimanya hipotesis penelitian 

(Ha) dari hasil pengujian “t” test pada taraf signifikan 5% dapat disimpulkan 

bahwa terdapat perbedaan yang signifikan antara penguasaan konsep photoshop 

yang menggunakan metode brainstorming dan metode tanya jawab. 
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4.3.5 Analisis Peningkatan Hasil belajar 

Analisis peningkatan hasil belajar pada penelitian ini menggunakan nilai g 

(gain) ternormalisasi, terangkum dalam diagram batang gambar 4.2. 

Berdasarkan penelitian yang dilakukan diperoleh rata-rata nilai pretest 

pada kelompok kontrol / tanya jawab adalah 54,78 Sedangkan rata-rata nilai 

postest yaitu 69,24 yang didapatkan dari nilai rata-rata aspek kognitif. Rata-rata 

nilai pretest pada kelompok eksperimen / brainstorming adalah  56,48, sedangkan 

rata-rata nilai postest yaitu 80,00 yang didapatkan dari nilai rata-rata aspek 

kognitif. 

Tabel 4.7 Data Hasil Belajar kelompok Eksperimen dan Kelompok Kontrol 

Kelompok Pretest Posttest 

Brainstorming / Eksperimen 56,48 80,00 

Tanya Jawab / Kontrol 54,78 69,24 

Dari data diatas dapat dibuat grafik  sebagai berikut 

 

 

Gambar  4.1. Grafik Hasil Belajar Kelas Eksperimen dan Kelas Kontrol 
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Gambar  4.2 Diagram Batang Uji N-Gain Hasil Belajar 

Hasil penelitian tersebut menunjukkan N-gain nilai kognitif kelompok 

eksperimen (0,54) lebih besar dari pada kelompok kontrol (0,31). Walaupun 

demikian, peningkatan hasil belajar keduanya pada materi membuat template 

website menggunakan photoshop sama-sama dikategorikan sedang.Untuk 

perhitungan uji N-gain hasil belajar dapat dilihat pada lampiran 19 dan 20. 

4.4 Pembahasan Penelitian 

Berdasarkan data akhir dari nilai posttest siswa kelas X RPL I dan X RPL 

II di SMKN 10 Semarang.Diperoleh hasil perhitungan data berdistribusi normal 

dan homogen. Dalam penelitian, kedua kelas diberi perlakuaan yang berbeda  

dalam proses pembelajaran. Dimana untuk kelas eksperimen yaitu kelas X RPL II 

diterapkan metode pembelajaran brainstorming. Sedangkan kelas kontrol yaitu 

kelas X RPL I diterapkan metode tanya jawab. 

Dalam pembelajaran metode brainstorming siswa terlibat aktif dalam 

kelompok untuk menghasilkan berbagai bentuk hasil belajar. Sedangkan metode 

pembelajaran tanya jawab pembelajaran berpusat pada guru, siswa dikelas diberi 

penjelasan materi oleh guru kemudian disertai tanya jawab. 
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Setelah kedua kelas diberi perlakuan yang berbeda maka untuk 

mengetahui perbedaan metode pembelajaran brainstorming dan metode tanya 

jawab terhadap penguasaan konsep photoshop siswa maka diakhir pertemuan 

diberikan tes akhir berupa posttest. 

Dari hasil analisis data akhir diperoleh hasil bahwa kemampuan  

penguasaan konsep photoshop siswa dengan  metode pembelajaran brainstorming 

lebih dari kemampuan  penguasaan konsep photoshop  siswa yang menggunakan  

metode pembelajaran tanya jawab. Jadi dapat dikatakan penguasaan konsep 

photoshop menggunakan metode pembelajaran brainstorming lebih tinggi 

daripada metode pembelajaran tanya jawab . Hal ini dikarenakan beberapa faktor, 

antara lain : 

1) Proses pembelajaran brainstorming, siswa dituntut bekerja sama dalam satu 

kelompok dan saling memberikan gagasan/ide sehingga siswa mengalami 

proses pembelajaran yang bermakna. Sedangkan dalam metode tanya jawab, 

proses pembelajaran hanya berpusat pada guru sehingga siswa cenderung 

pasif dan individual. 

2) Dalam pembelajaran brainstorming siswa disedikan alat gambar untuk 

mendesain hasil pemikirannya dan tiap siswa dalam kelompok diberi tugas 

masing-masing bagian dalam template web sehingga hasil belajar yang 

didapatpun lebih maksimal. 

3) Pembelajaran brainstorming dikelas eksperimen dilakukan dalam 

berkelompok. Keaktifan siswa dalam belajar berkelompok dapat 

membangun konsep dan pengetahuannya melalui pengalaman sendiri dan 
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berdiskusi dengan kelompoknya. Dengan belajar berkelompok juga dapat 

meningkatkan penguasaan konsep dalam pelajaran secara lisan maupun 

tertulis. Berbeda dengan kelas kontrol yang diterapkan metode tanya jawab, 

materi pelajaran diberikan oleh guru kemudian guru bertanya siswa 

menjawab atau sebaliknya. Akhirnya kemampuan dalam penguasaan materi 

juga kurang dan siswa mudah lupa dalam pelajaran yang diberikan dikelas. 

4.5 Keterbatasan Penelitian 

Berdasarkan hasil penelitian yang dilaksanakan selama 1 bulan, penulis 

mengakui bahwa ada beberapa keterbatasan dalam penelitian yang perlu 

diperhatikan diantaranya: 

1) Siswa dalam  kelas eksperimen belum terbiasa dengan belajar berkelompok 

sehingga sangat sulit untuk mengkondisikan siswa untuk berkelompok 

sesuai kelompok masing-masing. Oleh karena itu, perlu menjelaskan arti 

pentingnya belajar berkelompok pada awal pembelajaran. 

2) Terkadang masalah berkembang kearah yang tidak diharapkan, sehingga 

menyimpang dari pokok bahasan. Maka diperlukan kontrol guru yang kuat 

didalam pembelajaran yang berlangsung. 

3) Ada beberapa siswa yang kurang berpartisipasi dalam pembelajaran 

brainstorming maupun pembelajaran metode tanya jawab. Siswa tidak 

mendengarkan perintah guru/peneliti. Sehingga perlu diberikan perlakuan 

khusus seperti teguran agar siswa terlibat aktif dalam proses belajar 

mengajar.  
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BAB V 

KESIMPULAN DAN SARAN 

 

4.1 Kesimpulan 

Berdasarkan hasil dari penelitian dan analisis data, maka dapat 

disimpulkan bahwa: 

1. Penggunaan metode mengajar brainstorming dapat meningkatkan 

pengusaan konsep photoshop siswa. 

2. Belum terbiasa dengan belajar berkelompok dan siswa yang pasif 

merupakan kendala dalam pembelajaran brainstorming. 

3. Berdasarkan hasil perhitungan post-test, kelompok yang menggunakan 

metode brainstorming memberikan hasil yang lebih baik, terbukti dengan 

rata-rata sebesar  80,00 dibanding kelompok yang menggunakan metode 

tanya jawab dengan rata-rata sebesar 69,24. 

4. Setelah dilakukan analisis data dengan menggunakan uji-t, terdapat 

perbedaan yang signifikan antara penguasaan konsep siswa pada kelompok 

yang menggunakan brainstorming dan kelompok yang menggunakan 

metode tanya jawab.Peningkatan hasil belajar kedua kelompok 

menunjukkan N-gain nilai kognitif kelompok eksperimen 0,54 % lebih 

besar dari pada kelompok kontrol 0,31 %. 
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4.2 Saran 

Berdasarkan kesimpulan dari penelitian ini, saran-saran yang diajukan 

adalah sebagai berikut : 

1. Karena model pembelajaran brainstorming yang diterapkan membutuhkan 

waktu yang cukup lama, maka guru perlu mengatur waktu dalam diskusi 

kelompok agar pembelajaran berjalan lebih maksimal. 

2. Menerapkan pembelajaran dengan metode brainstorming tidak hanya pada 

pelajaran desain grafis tetapi pada pelajaran lain juga. 

3. Guru hendaknya lebih sering mengadakan diskusi kelompok pada 

pembelajaran, agar siswa terbiasa belajar dan bekerja sama dalam 

kelompok sehingga dapat mengasah kemampuan penguasaan materi baik 

lisan maupun tertulis pada siswa.   
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Lampiran 1 

 

RENCANA PELAKSANAAN PEMBELAJARAN 

Mata Pelajaran  : DESAIN GRAFIS 

Satuan Pendidikan  : SMKN 10 Semarang 

Kelas/Semester  : X / 2 

Standar Kompetensi  : Menggunakan perangkat lunak pembuat grafis  

Alokasi waktu   : 2 X 45 menit ( 4 Pertemuan ) 

I. KOMPETENSI DASAR : 

Membuat grafis dengan berbagai variasi warna, bentuk, dan ukuran 

 

II. INDIKATOR 

Membuat beberapa kreasi grafis 

 

III. TUJUAN PEMBELAJARAN  

1. Siswa dapat mengatur tampilan ukuran dan warna halaman 

2. Siswa dapat membuat kreasi grafis dengan menggabungkan dan 

memodifikasi garis dan bentuk 

3. Siswa dapat mengatur pewarnaan pada grafis 

4. Siswa dapat menerapkan efek sederhana dan lanjutan pada grafis  

5. Siswa dapat melakukan pencetakan dan/atau penampilan (publish) 

grafis 

6. Siswa dapat membuat desain template website 

 

IV. STRATEGI PEMBELAJARAN 

Metode   : Tanya Jawab 

Model  : Diskusi, Tanya Jawab, Penugasan 
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V. LANGKAH – LANGKAH PEMBELAJARAN 

( 2 X 45 menit ) Pertemuan Pertama 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai. 

 Apresiasi oleh guru desain grafis. 

 Peneliti membagikan soal tes kognitif (pretest) 

kepada siswa. 

 Pemberian informasi tujuan pembelajaran. 

40 menit 

Kegiatan 

Inti 

Eksplorasi, Elaborasi, Konfirmasi 

 Peneliti menjelaskan sekilas tentang photoshop 

sebelum memasuki materi yang akan dibahas. 

 Peneliti bertanya kepada siswa tentang materi yang 

dibahas atau siswa bertanya kepada peneliti. 

 Kemudian tentang jenis – jenis style dalam objek 

kerja ,diakhiri penjelasan tentang struktur halaman 

web. 

40 menit 

 

 

 

 

 

Kegiatan 

Akhir 

 Peneliti menjelaskan rencana pembelajaran untuk 

minggu depan. 

 Peneliti menutup pembelajaran dan memberi 

kesimpulan. 

10 menit 

 

( 2 X 45 menit ) Pertemuan Kedua 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai. 

 Peneliti dan guru mengatur kondisi kelas. 

 Peneliti menjelaskan tujuan dari materi yang akan 

dipelajari. 

20 menit 
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Kegiatan 

Inti 

Eksplorasi 

 Peneliti menjelaskan kembali tentang pelajaran 

minggu lalu dengan cara memberikan pertanyaan 

kepada siswa. 

 Setelah selesai memberikan pertanyaan maupun 

menjawab pertanyaan, peneliti akan memberikan 

materi photoshop tentang membuat website dengan 

efek aurora. 

Elaborasi 

 Peneliti menginstruksikan kepada masing-masing 

siswa untuk membuat sketsa desain web. 

 Peneliti dan guru berkeliling untuk mengecek 

kinerja siswa apakah sudah bekerja dengan baik. 

Konfirmasi 

 Peneliti dan guru mengkonfirmasi tugas yang 

diberikan kepada siswa. 

40 menit  

 

 

 

 

 

 

 

 

20 menit 

 

 

 

 

5 menit 

Kegiatan 

Akhir 

 Peneliti menjelaskan rencana pembelajaran untuk 

minggu depan. 

 Peneliti memberikan kesimpulan pembelajaran 

5 menit 

 

( 2 X 45 menit ) Pertemuan Ketiga 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai 

 Peneliti menjelaskan tujuan dari materi yang akan 

dipelajari 

10 menit 

Kegiatan 

Inti 

Eksplorasi, Elaborasi, Konfirmasi 

 Peneliti menginstruksikan kepada siswa untuk 

melanjutkan membuat desain web  menggunakan 

photoshop. 

65 menit  
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 Masing-masing siswa harus membuat desain 

template website. 

 Setelah selesai membuat desain, peneliti akan 

menawarkan kepada siswa untuk mempresentasikan 

hasil yang dibuat  kepada teman sekelasnya. 

Kegiatan 

Akhir 

 Peneliti menjelaskan rencana pembelajaran untuk 

minggu depan. 

 Peneliti memberikan kesimpulan pembelajaran 

15 menit 

 

( 2 X 45 menit ) Pertemuan Keempat 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai 

 Peneliti menjelaskan tujuan dari materi yang akan 

dipelajari 

10 menit 

Kegiatan 

Inti 

Eksplorasi, Elaborasi, Konfirmasi 

 Peneliti menginstruksikan kembali kepada siswa 

untuk membuat desain menggunakan photoshop. 

 Setelah selesai membuat desain, peneliti akan 

menawarkan kepada siswa untuk mempresentasikan 

hasil yang dibuat  kepada teman sekelasnya. 

 Siswa yang lain boleh bertanya atau memberi 

masukkan dari hasil desain web yang telah dibuat. 

40 menit  

Kegiatan 

Akhir 

 Peneliti membagikan soal tes kognitif (postest) 

kepada siswa 

 Peneliti memberikan kesimpulan pembelajaran 

40 menit 

 

VI. MEDIA PEMBELAJARAN 

1. Media Pembelajaran : 

Buku Adobe Photoshop untuk Desainer Web 
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2. Alat Pembelajaran : 

a. LCD Proyektor 

b. Laptop atau Komputer 

c. White board 

 

 

 

 

 

 

 

 

 

VII. PENILAIAN  

a. Prosedur  Penilaian dan Instrumen 

Lembar Tes Kognitif 

Penilaian Sikap : Lembar pengamatan afektif siswa ( terlampir ) 

Penilaian Aktivitas : Lembar pengamatan aktivitas siswa ( terlampir ) 

 

 

 

Mengetahui, 

Guru Mapel Desain Grafis               Peneliti 

 

 

 

 

Andhen Priyono, S.Kom, M.Kom   Elfa Aizah Arum P 

NIP.        NIM. 5302411096 
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Lampiran 2 

RENCANA PELAKSANAAN PEMBELAJARAN 

Mata Pelajaran  : DESAIN GRAFIS 

Satuan Pendidikan  : SMKN 10 Semarang 

Kelas/Semester  : X / 2 

Standar Kompetensi  : Menggunakan perangkat lunak pembuat grafis  

Alokasi waktu   : 2 X 45 menit ( 4 Pertemuan ) 

 

I. KOMPETENSI DASAR : 

Membuat grafis dengan berbagai variasi warna, bentuk, dan ukuran 

 

II. INDIKATOR 

Membuat beberapa kreasi grafis 

 

III. TUJUAN PEMBELAJARAN  

1. Siswa dapat mengatur tampilan ukuran dan warna halaman 

2. Siswa dapat membuat kreasi grafis dengan menggabungkan dan 

memodifikasi garis dan bentuk 

3. Siswa dapat mengatur pewarnaan pada grafis 

4. Siswa dapat menerapkan efek sederhana dan lanjutan pada grafis  
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5. Siswa dapat melakukan pencetakan dan/atau penampilan (publish) 

grafis 

6. Siswa dapat membuat desain template website 

 

IV. STRATEGI PEMBELAJARAN 

Metode   : Brainstorming 

Model  : Diskusi, Penugasan dan Presentasi 

Pendekatan  : Keterampilan Proses 

V. LANGKAH – LANGKAH PEMBELAJARAN 

( 2 X 45 menit ) Pertemuan Pertama 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai. 

 Apresiasi oleh guru desain grafis. 

 Peneliti membagikan soal tes kognitif ( pretest ) 

kepada siswa. 

 Pemberian informasi tujuan pembelajaran. 

40 menit 

Kegiatan 

Inti 

Eksplorasi, Elaborasi, Konfirmasi 

 Peneliti menjelaskan sekilas tentang photoshop 

sebelum memasuki materi yang akan dibahas. 

 Kemudian tentang jenis – jenis style dalam objek 

kerja ,diakhiri penjelasan tentang struktur halaman 

web. 

40 menit 

Kegiatan 

Akhir 

 Peneliti menjelaskan rencana pembelajaran 

brainstorming untuk minggu depan. 

 Peneliti menutup pembelajaran dan memberi 

kesimpulan. 

10 menit 

 

( 2 X 45 menit ) Pertemuan Kedua 



71 

 

 

 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai. 

 Peneliti dan guru mengatur kondisi kelas sesuai 

dengan rencana. 

 Peneliti mempersiapkan alat/komputer yang akan 

digunakan. 

 

20 menit 

Kegiatan 

Inti 

Eksplorasi 

 Peneliti dan guru membagi siswa menjadi 7 

kelompok masing-masing beranggotakan 4 - 5 siswa 

dan menunjuk ketua kelompok. 

 Peneliti menjelaskan peraturan dalam pembelajaran 

brainstorming. 

 Peneliti memberikan materi photoshop tentang 

membuat website dengan efek aurora. 

Elaborasi 

 Peneliti menginstruksikan kepada masing-masing 

siswa untuk membuat sketsa desain web. 

 Ketua kelompok wajib membimbing anggotanya.  

 Peneliti dan guru berkeliling  untuk mengecek 

kinerja tim apakah sudah bekerja dengan baik. 

Konfirmasi 

 Peneliti dan guru  mengkonfirmasi tugas yang 

diberikan kepada siswa. 

40 menit 

 

 

 

 

 

 

 

 

 

20 menit 

 

 

 

 

 

5 menit 

Kegiatan 

Akhir 

 Peneliti menjelaskan rencana pembelajaran 

brainstorming untuk minggu depan. 

 Peneliti menutup pembelajaran dan memberi 

kesimpulan. 

5 menit 
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( 2 X 45 menit ) Pertemuan Ketiga 

Kegiatan Uraian Kegiatan Waktu 

Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai. 

 Peneliti dan guru mengatur kondisi kelas sesuai 

dengan rencana. 

 Peneliti mempersiapkan alat/komputer yg digunakan 

20 menit 

Kegiatan 

Inti 

Eksplorasi, Elaborasi, Konfirmasi 

 Peneliti menginstruksikan kepada siswa untuk 

melanjutkan tugas yang diberikan kemarin. 

 Peneliti memberikan waktu kepada tiap kelompok 

untuk menggabungkan ide masing-masing desain 

yang dimiliki. 

 

 Kelompok siswa membuat desain tersebut yang 

dipimpin oleh ketua kelompok. 

 Masing-masing kelompok harus membuat desain 

yang telah disepakati bersama. 

 Setelah selesai membuat desain, peneliti akan 

menawarkan kepada kelompok untuk 

mempresentasikan hasil yang dibuat  kepada teman 

sekelasnya. 

60 menit  

Kegiatan 

Akhir 

 Peneliti menjelaskan rencana pembelajaran 

brainstorming untuk minggu depan. 

 Peneliti menutup pembelajaran dan memberi 

kesimpulan. 

10 menit 

 

( 2 X 45 menit ) Pertemuan Keempat 

Kegiatan Uraian Kegiatan Waktu 
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Kegiatan 

Awal 

Pendahuluan 

 Berdoa sebelum pelajaran dimulai. 

 Peneliti dan guru mengatur kondisi kelas sesuai 

dengan rencana. 

 Peneliti mempersiapkan alat/komputer yang akan 

digunakan. 

10 menit 

Kegiatan 

Inti 

Eksplorasi, Elaborasi, Konfirmasi 

 Peneliti memberikan waktu kepada tiap kelompok 

untuk menggabungkan ide masing-masing desain 

yang dimiliki. 

 Peneliti menawarkan kepada kelompok yang ingin 

mempresentasikan hasil website yang telah dibuat. 

40 menit  

Kegiatan 

Akhir 

 Peneliti membagikan soal tes kognitif (posttest) 

kepada siswa. 

 Peneliti memberikan kesimpulan pembelajaran. 

40 menit 

 

 

 

VI. MEDIA PEMBELAJARAN 

3. Media Pembelajaran : 

a. Buku Adobe Photoshop untuk Desainer Web 

 

4. Alat Pembelajaran : 

d. LCD Proyektor 

e. Laptop atau Komputer 

f. White board 

 

VII. PENILAIAN  

a. Prosedur  Penilaian dan Instrumen 

Lembar Tes Kognitif 

Penilaian Sikap : Lembar pengamatan afektif siswa ( terlampir ) 

Penilaian Aktivitas : Lembar pengamatan aktivitas siswa ( terlampir ) 
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Mengetahui, 

Guru Mapel Desain Grafis    Peneliti 

 

 

 

 

Anden Priyono. S.Kom, M.Kom  Elfa Aizah Arum P 

NIP.       NIM. 5302411096 

 

 

 

 

 

 

 

 

Lampiran 3 

DAFTAR NAMA DAN KODE KELAS UJI COBA ( XI RPL I) 

No Kode Nama Siswa 

1 UC-01 A. SYAIFUDIN 

2 UC-02 ANNIS ANITASARI 

3 UC-03 BAGUS SYAIFUL ANAN 

4 UC-04 BAYU ANDREANSYAH 

5 UC-05 ELVERA INDAHSARI MA'RIFAH 

6 UC-06 FACHRI SETIAWAN 

7 UC-07 FEBBY DWIKI UTAMI 

8 UC-08 FIFI OKTANINGTYAS 

9 UC-09 FIFIANA NITASARI 

10 UC-10 FIRMAN AJI PRATAMA 
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11 UC-11 GEMA PUTRA PRATAMA 

12 UC-12 HENRY EKA SAPUTRA 

13 UC-13 IKA PRATIWI DAMAYANTI 

14 UC-14 IRA YULIANA 

15 UC-15 ISNAENI SAFITRI 

16 UC-16 KRESNA ADEVERRA 

17 UC-17 MEGGY ADHITYA NUGRAHANTO 

18 UC-18 MOHAMAD SAFI'I 

19 UC-19 MUHAMMAD ERI KANTONO 

20 UC-20 NANDA NUR AZIZAH 

21 UC-21 OSCHARIL AJI MUKTI 

22 UC-22 PUPUT MEYLIA 

23 UC-23 RAFLI NUGRAHA FENDINO 

24 UC-24 RICO DAVID SETIAWAN 

25 UC-25 RIZKY KURNIAWAN 

26 UC-26 RONI EKA SETIAWAN 

27 UC-27 SAFIRA BERLIANA YULFARIDA A 

28 UC-28 SEKAR AYU VENINA 

29 UC-29 SIGIT ARI MIARTO 

30 UC-30 SURYO OCTAV MULYONO 

31 UC-31 SYAWAL IKA LYONTIN 

32 UC-32 TEODORUS RAYNALDY K, 
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Lampiran 4 

Hasil Analisis Uji Coba Soal 
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Lampiran 5 

PERHITUNGAN VALIDITAS BUTIR SOAL 

Rumus : 

    
 ∑   (∑ )(∑ )

√* ∑   (∑ ) +* ∑   (∑ ) +
 

Keterangan : 

     : koefisien antara x dan y 

             : banyaknya subjek yang diteliti 

∑   :jumlah skor tiap butir soal 

∑   : jumlah skor total 

∑    : jumlah kali skor tiap butir soal dengan skor total    

∑    : jumlah kuadrat skor butir soal 

∑    : jumlah kuadrat skor total 

Kriteria : 

Jika    >       maka butir soal dinyatakan valid. 

Perhitungan ini disajikan untuk perhitungan validitas butir soal nomor 2. 

No Kode X Y X² Y² XY 

1 UC-01 0 19 0 361 0 

2 UC-02 1 27 1 729 27 

3 UC-03 1 32 1 1024 32 

4 UC-04 1 38 1 1444 38 

5 UC-05 1 30 1 900 30 

6 UC-06 1 44 1 1936 44 

7 UC-07 0 24 0 576 0 

8 UC-08 1 32 1 1024 32 

9 UC-09 1 27 1 729 27 

10 UC-10 0 25 0 625 0 

11 UC-11 1 45 1 2025 45 

12 UC-12 0 34 0 1156 0 

13 UC-13 1 32 1 1024 32 

14 UC-14 0 24 0 576 0 

15 UC-15 1 32 1 1024 32 

16 UC-16 1 30 1 900 30 

17 UC-17 1 26 1 676 26 
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18 UC-18 0 27 0 729 0 

19 UC-19 1 30 1 900 30 

20 UC-20 1 32 1 1024 32 

21 UC-21 1 32 1 1024 32 

22 UC-22 0 20 0 400 0 

23 UC-23 1 28 1 784 28 

24 UC-24 1 31 1 961 31 

25 UC-25 1 43 1 1849 43 

26 UC-26 1 33 1 1089 33 

27 UC-27 1 33 1 1089 33 

28 UC-28 1 44 1 1936 44 

29 UC-29 1 45 1 2025 45 

30 UC-30 0 18 0 324 0 

31 UC-31 0 21 0 441 0 

32 UC-32 0 26 0 676 0 

∑  22 984 22 31980 746 

∑
 

 484 968256    

 

    
 ∑   (∑ )(∑ )

√* ∑   (∑ ) +* ∑   (∑ ) +
 

 
  (   )  (  )(   )

√*(  )(  )     +*(  )(     )        +
 

 
            

√(       )(              )
 

 
    

√(   )(     )
 

       

Berdasarkan perhitungan diperoleh harga    = 0,639 dan dengan taraf signifikan 

5% dan N = 32 diperoleh        = 0,2960. Karena    >       maka butir soal 

nomor 2 valid. 
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Lampiran 6 

 

PERHITUNGAN REABILITAS INSTRUMEN 

Rumus : 

 
    (

 

   
)(
   ∑  

  
)

 

Keterangan : 

     :reabilitas  tes secara keseluruhan 

   : proporsi subjek yang menjawab item dengan benar 

   :proporsisubjek yang menjawab item dengan salah 

∑    : jumlah hasil perkalian antara p dan q 

   :banyaknya item 

   : standar deviasi dari tes  

( standar deviasi adalah  akar varians). 

 

Kriteria : 

Jika    > rtabel maka soal dikatakan reliabel. 

 

Perhitungan 

Berdasarkan tabel pada analisis ujicoba diperoleh: 

∑pq = pq1 + pq2 + pq3 + …. +pq35 

 = 0 + 0,2217 + 0,2328 + …. + 0,2328+0 

 = 6,5 

 

   
∑   

(∑ ) 
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    = 55,54 

n = 50 

∑pq =  6,5 

    (
 

   
)(
   ∑  

  
) 

 (
  

    
) (
          

     
) 

= 0,91 

 

Pada ɑ= 5% dan n= 32, diperoleh rtabel = 0,296 

Karena r11 = 0,91> rtabel= 0,296 maka alat ukur/alat evaluasi tersebut sudah 

reliabel. 
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Lampiran 7 

 

PERHITUNGAN TINGKAT KESUKARAN BUTIR SOAL 

Rumus : 

  
 

  
 

Keterangan : 

P   : tingkat kesukaran soal 

B  : banyaknya siswa yang menjawab soal itu dengan benar 

Js  : jumlah seluruh siswa peserta tes 

Kriteria : 

TK > 0,7   : Mudah 

TK = 0,3 sampai 0,7  : Sedang 

TK < 0,3   : Sukar 

 

Perhitungan ini disajikan untuk perhitungan tingkat kesukaran butir soal 

nomor 1 – 5. 

No Kode 
Butir Soal 

1 2 3 4 5 

1 UC-01 1 0 0 0 1 

2 UC-02 1 1 1 0 1 

3 UC-03 1 1 1 0 1 

4 UC-04 1 1 1 0 1 

5 UC-05 1 1 1 0 1 

6 UC-06 1 1 0 1 1 

7 UC-07 1 0 0 0 1 

8 UC-08 1 1 1 0 1 

9 UC-09 1 1 1 0 1 

10 UC-10 1 0 0 0 1 

11 UC-11 1 1 1 1 1 

12 UC-12 1 0 0 1 1 
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13 UC-13 1 1 1 0 1 

14 UC-14 1 0 0 0 1 

15 UC-15 1 1 1 0 1 

16 UC-16 1 1 1 0 1 

17 UC-17 1 1 1 0 1 

18 UC-18 1 0 0 1 0 

19 UC-19 1 1 1 0 1 

20 UC-20 1 1 1 0 1 

21 UC-21 1 1 1 0 1 

22 UC-22 1 0 0 0 0 

23 UC-23 1 1 1 0 1 

24 UC-24 1 1 1 0 1 

25 UC-25 1 1 1 1 0 

26 UC-26 1 1 1 0 1 

27 UC-27 1 1 1 0 1 

28 UC-28 1 1 1 1 1 

29 UC-29 1 1 1 1 1 

30 UC-30 1 0 0 0 1 

31 UC-31 1 0 0 0 1 

32 UC-32 1 0 0 1 1 

Jumlah 32 22 21 8 29 

Rata - Rata 1 0,687 0,656 0,25 0,906 

Keterangan MUDAH SEDANG SEDANG SUKAR MUDAH 

 

Tingkat kesukaran butir soal nomor 1 =
  

  
 = 1   ( Mudah ) 

Tingkat kesukaran butir soal nomor 2 =
  

  
 = 0,687 ( Sedang ) 

Tingkat kesukaran butir soal nomor 3 =
  

  
 = 0,656 ( Sedang ) 

Tingkat kesukaran butir soal nomor 4 =
 

  
 = 0,25 ( Sukar ) 

Tingkat kesukaran butir soal nomor 5 =
  

  
 = 0,906 ( Mudah ) 
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Lampiran 8 

 

PERHITUNGAN DAYA PEMBEDA BUTIR SOAL 

Rumus : 

   
  
  
 
  
  

 

Keterangan : 

DP : daya pembeda soal 

   : jumlah jawaban benar dari kelompok atas 

   : jumlah jawaban benar dari kelompok bawah 

JA : jumlah siswa pada kelompok atas 

JB : jumlah siswa pada kelompok bawah  

Klasifikasi daya pembeda : 

DP = 0,00 – 0,20 : jelek atau kurang baik 

DP = 0,21 – 0,40 : cukup 

DP = 0,41 – 0,70 : baik 

DP = 0,71 – 1,00 : baik sekali 

 

Perhitungan ini disajikan untuk perhitungan daya pembeda butir soal 

nomor 1 – 5. 

No Kode 

Kelompok Atas 

Butir Soal 

1 2 3 4 5 

11 UC-11 1 1 1 1 1 

29 UC-29 1 1 1 1 1 

6 UC-06 1 1 0 1 1 
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28 UC-28 1 1 1 1 1 

25 UC-25 1 1 1 1 0 

4 UC-04 1 1 1 0 1 

12 UC-12 1 0 0 1 1 

26 UC-26 1 1 1 0 1 

27 UC-27 1 1 1 0 1 

3 UC-03 1 1 1 0 1 

8 UC-08 1 1 1 0 1 

Jumlah Benar 11 10 9 6 10 

 

No Kode 

Kelompok Bawah 

Butir Soal 

1 2 3 4 5 

9 UC-09 1 1 1 0 1 

18 UC-18 1 0 0 1 0 

17 UC-17 1 1 1 0 1 

32 UC-32 1 0 0 1 1 

10 UC-10 1 0 0 0 1 

7 UC-07 1 0 0 0 1 

14 UC-14 1 0 0 0 1 

31 UC-31 1 0 0 0 1 

22 UC-22 1 0 0 0 0 

1 UC-01 1 0 0 0 1 

30 UC-30 1 0 0 0 1 

Jumlah Benar 11 2 2 2 9 

 

Daya pembeda butir soal 1 = 
  

  
  

  

  
 = 0 ( Jelek atau kurang baik) 

Daya pembeda butir soal 2 = 
  

  
  

 

  
 = 0,727 ( Baik Sekali ) 

Daya pembeda butir soal 3 = 
 

  
  

 

  
 = 0,636 ( Baik ) 

Daya pembeda butir soal 4 = 
 

  
  

 

  
 = 0,363 ( Cukup ) 

Daya pembeda butir soal 5 = 
  

  
  

 

  
 = 0,090 (Jelek atau kurang baik) 
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Lampiran 9 

 

UJI KESAMAAN DUA RATA-RATA  HASIL PRE TEST 

ANTARA KELAS X RPL I DAN X RPL II 

 

Hipotesis 

H0:µ1   =  µ2 ( kemampuan  penguasaan konsep photoshop siswakelas X RPL I 

sama dengan kemampuan  penguasaan konsep photoshop  

siswaKelas X RPL II). 

Ha  :µ1   =  µ2 (kemampuan  penguasaan konsep photoshop siswakelas X RPL I 

tidak sama dengan kemampuan  penguasaan konsep photoshop  

siswaKelas X RPL II) 

Rumus yang dipakai: 

 

 

Dengan  
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( Sudjana, 2005:239) 

 

Keterangan : 

        : nilait hitung 

   : rata-rata kemampuan penguasaan konsep photoshop kelas X RPL II 

   : rata-rata kemampuan penguasaan konsep photoshop kelas X RPL I 

   : banyaknya subjek kelas X RPL II 

   : banyaknya subjek kelas X RPL I 

  ² : varians kelas X RPL II 

  ² : varians kelas X RPL I 

S : simpangan baku gabungan 

Kriteria Pengujian 

Kriteria pengujian adalah Ho diterima jika        < (   )(       )        

diperoleh dari  table distribusi t  dengan taraf nyata 5% dan dk = (n1+ n2 - 2). 

Statistik Hitung 

Sumber Variasi Kelas X RPL II Kelas X RPL I 

Jumlah 1864 1808 

X 56,48 54,79 

Varians 59,195 51,797 

N 33 33 

 

Sehingga diperoleh, 

  
√((    )       (    )      )

       
 

   = 6,449 

 
           

           

     √
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 = 0,925 

 

Dari hasil perhitungan diperoleh harga         = 0,925 

Untuk taraf signifikan 5% dengan dk = 33 + 33 - 2 = 64 diperoleh        = 1,998 

Karena        <      , maka H0 diterima dan Ha ditolak. 

Jadi, kemampuan  penguasaan konsep photoshop siswakelas X RPL I sama 

dengan kemampuan  penguasaan konsep photoshop  siswaKelas X RPL II. 

Sehingga ditetapkan untuk kelas X RPL I sebagai kelas kontrol dan kelas X RPL 

II sebagai kelas eksperimen. 
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Lampiran 10 

 

DATA AWAL (PRETEST) DAN DATA AKHIR ( POSTTEST) 

KELAS KONTROL ( X RPL I) 

No Kode Nilai  Pretest Nilai Posttest 

1 KK-01 53 70 

2 KK-02 56 66 

3 KK-03 66 70 

4 KK-04 53 73 

5 KK-05 60 80 

6 KK-06 53 73 

7 KK-07 50 70 

8 KK-08 43 60 

9 KK-09 46 63 

10 KK-10 56 60 

11 KK-11 66 73 

12 KK-12 46 66 

13 KK-13 60 63 

14 KK-14 70 70 

15 KK-15 56 66 

16 KK-16 50 60 

17 KK-17 60 76 

18 KK-18 46 63 

19 KK-19 46 76 

20 KK-20 56 73 

21 KK-21 60 66 

22 KK-22 46 76 

23 KK-23 50 76 

24 KK-24 46 76 



92 

 

 

 

25 KK-25 53 66 

26 KK-26 46 66 

No Kode Nilai  Pretest Nilai Posttest 

27 KK-27 56 73 

28 KK-28 60 70 

29 KK-29 50 66 

30 KK-30 60 63 

31 KK-31 63 70 

32 KK-32 60 66 

33 KK-33 66 80 

Jumlah 1808 2285 

Rata - Rata 54,788 69,242 

Nilai Minimal 43 60 

Nilai Maksimal 70 80 

Varians 51,797 32,189 

Standart Deviasi 

 
7,197 5,674 
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Lampiran 11 

 

DATA AWAL (PRETEST) DAN DATA AKHIR (POSTTEST ) 

KELAS EKSPERIMEN ( X RPL II) 

No Kode Nilai Pretest Nilai Posttest 

1 KE-01 63 77 

2 KE-02 60 73 

3 KE-03 53 83 

4 KE-04 60 80 

5 KE-05 60 77 

6 KE-06 50 87 

7 KE-07 53 73 

8 KE-08 40 80 

9 KE-09 56 67 

10 KE-10 36 80 

11 KE-11 63 93 

12 KE-12 63 80 

13 KE-13 53 80 

14 KE-14 63 83 

15 KE-15 60 90 

16 KE-16 53 87 

17 KE-17 60 93 

18 KE-18 56 67 

19 KE-19 43 60 

20 KE-20 63 77 

21 KE-21 46 80 

22 KE-22 60 80 

23 KE-23 63 93 
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24 KE-24 53 70 

25 KE-25 43 83 

No Kode Nilai Pretest Nilai Posttest 

26 KE-26 63 77 

27 KE-27 66 80 

28 KE-28 60 77 

29 KE-29 63 87 

30 KE-30 53 80 

31 KE-31 63 80 

32 KE-32 63 83 

33 KE-33 60 83 

Jumlah 1864 2640 

Rata - Rata 56,485 80,000 

Nilai Minimal 36 60 

Nilai Maksimal 66 93 

Varians 59,195 56,944 

Standart Deviasi 7,694 7,546 
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Lampiran 12 

 

DAFTAR KELOMPOK KELAS BRAINSTORMING ( X RPL II) 

KELOMPOK 1 

 Fahreza Dandy 

 Putri Rahayu 

 Aulia Dinda 

 Muhammad Vicky 

KELOMPOK 2 

 Anggita Nurmalasari 

 Miftahul Baiton 

 Andika Tria Asmara 

 Dwi Prasyaningsih 

 

KELOMPOK 3 

 Diana Ridwan Putri 

 Adef Bagas Putra 

 Kevin Muhammad 

 Puji Dewi Astuti 

 Ramadhanu 

KELOMPOK 4 

 Hani Addaroni 

 Difa Putri N.D 

 Agung Royhans 

 Erisal 

 Rozi Fargiy 

 

KELOMPOK 5 

 Natanael Kevin 

 Mella Noviara 

 Religiawan 

 Suci Widyawati 

 Dani Afandi 

KELOMPOK 6 

 Yuliana 

 Firman Adji 

 Syahril Dika R 

 Archangela Dias 

 Mahfud Syuchri 

 

KELOMPOK 7 

 Arfian Kresmanto 

 Nur Tiger Bunga 

 Hadid Reza Pahlevi 

 Radiva Wahyu 

 Khofifah Indah 
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Lampiran 13 

Perhitungan “t” test pada Kelompok Tanya Jawab 

No Kode 
Nilai 

Pretest 

Nilai 

Posttest 
Gain Xd Xd² 

1 KK-01 53 70 17 2,55 6,48 

2 KK-02 56 66 10 10,00 100,00 

3 KK-03 66 70 4 4,00 16,00 

4 KK-04 53 80 27 27,00 729,00 

5 KK-05 60 73 13 13,00 169,00 

6 KK-06 53 73 20 20,00 400,00 

7 KK-07 50 70 20 20,00 400,00 

8 KK-08 43 60 17 17,00 289,00 

9 KK-09 46 63 17 17,00 289,00 

10 KK-10 56 60 4 4,00 16,00 

11 KK-11 66 73 7 7,00 49,00 

12 KK-12 46 66 20 20,00 400,00 

13 KK-13 60 63 3 3,00 9,00 

14 KK-14 70 66 -4 -4,00 16,00 

15 KK-15 56 70 14 14,00 196,00 

16 KK-16 50 60 10 10,00 100,00 

17 KK-17 60 76 16 16,00 256,00 

18 KK-18 46 63 17 17,00 289,00 

19 KK-19 46 76 30 30,00 900,00 

20 KK-20 56 73 17 17,00 289,00 

21 KK-21 60 66 6 6,00 36,00 

22 KK-22 46 76 30 30,00 900,00 

23 KK-23 50 76 26 26,00 676,00 

24 KK-24 46 76 30 30,00 900,00 

25 KK-25 53 66 13 13,00 169,00 

26 KK-26 46 66 20 20,00 400,00 
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27 KK-27 56 73 17 17,00 289,00 

No Kode 
Nilai 

Pretest 

Nilai 

Posttest 
Gain Xd Xd² 

28 KK-28 60 70 10 10,00 100,00 

29 KK-29 50 66 16 16,00 256,00 

30 KK-30 60 63 3 3,00 9,00 

31 KK-31 63 70 7 7,00 49,00 

32 KK-32 60 66 6 6,00 36,00 

33 KK-33 66 80 14 14,00 196,00 

Jumlah 1808 2285 
477 

  

8934,48 

  Rata - Rata 54,788 69,242 

 

Md = 
∑ 

 
 

 = 477 : 33 = 14,45 

   
     

√
       

   (    )

 

   
     

√
       

    

 

   
     

      
        

 

db=33-1=32 

t table (0,05) = 2,025 

Karena        >       maka dapat disimpulkan bahwa terdapat perbedaan 

penguasaan konsep photoshop sebelum dan sesudah pembelajaran yang 

signifikan. 
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Lampiran 14 

Perhitungan “t” test pada Kelompok Brainstorming 

No Kode 
Nilai 

Pretest 

Nilai 

Posttest 
GAIN Xd Xd² 

1 KE-01 63 77 14 -9,85 96,99 

2 KE-02 60 73 13 13,33 177,78 

3 KE-03 53 83 30 30,33 920,11 

4 KE-04 60 80 20 20,00 400,00 

5 KE-05 60 77 17 16,67 277,78 

6 KE-06 50 87 37 36,67 1344,44 

7 KE-07 53 73 20 20,33 413,44 

8 KE-08 40 80 40 40,00 1600,00 

9 KE-09 56 67 11 10,67 113,78 

10 KE-10 36 80 44 44,00 1936,00 

11 KE-11 63 93 30 30,33 920,11 

12 KE-12 63 80 17 17,00 289,00 

13 KE-13 53 80 27 27,00 729,00 

14 KE-14 63 83 20 20,33 413,44 

15 KE-15 60 90 30 30,00 900,00 

16 KE-16 53 87 34 33,67 1133,44 

17 KE-17 60 93 33 33,33 1111,11 

18 KE-18 56 67 11 -12,85 165,08 

19 KE-19 43 60 17 17,00 289,00 

20 KE-20 63 77 14 13,67 186,78 

21 KE-21 46 80 34 34,00 1156,00 

22 KE-22 60 80 20 20,00 400,00 

23 KE-23 63 93 30 6,82 46,49 

24 KE-24 53 70 17 17,00 289,00 

25 KE-25 43 83 40 40,33 1626,78 

26 KE-26 63 77 14 13,67 186,78 
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27 KE-27 66 80 14 14,00 196,00 

No Kode 
Nilai 

Pretest 

Nilai 

Posttest 
GAIN Xd Xd² 

28 KE-28 60 77 17 -6,85 46,90 

29 KE-29 63 87 24 23,67 560,11 

30 KE-30 53 80 27 27,00 729,00 

31 KE-31 63 80 17 17,00 289,00 

32 KE-32 63 83 20 20,33 413,44 

33 KE-33 60 83 23 -0,18 0,03 

Jumlah 1864 2640 
776 

 

19356,83 
Rata - Rata 56,485 80,000 

 

Md = 
∑ 

 
 

= 776 : 33 = 23,52 

   
     

√
        

   (    )

 

 

   
     

√
        

    

 

   
     

     
       

 

db=33-1=32 

t table (0,05) = 2,025 

Karena        >       maka dapat disimpulkan bahwa terdapat perbedaan 

penguasaan konsep photoshop sebelum dan sesudah pembelajaran yang 

signifikan. 
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Lampiran 15 

 

UJI NORMALITAS DATA AKHIR KELAS KONTROL 

( X RPL I ) 

Hipotesis 

Ho : distribusi data akhir berdistribusi normal 

Ha : distribusi data akhir tidak berdistribusi normal 

Rumus  

 

  

Keterangan: 

   : chi kuadrat 

   : frekuensi yang diperoleh dari data penelitian 

   : frekuensi yang diharapkan 

  : banyak kelas interval 

Kriteria Pengujian 

Ho diterima jika          <        yaitu         <  (   ) (   ) dengan taraf 

signifikan ( ) =5% dan dk = (k - 3). 

Statistik Hitung 

Nilai Maksimum  80 

Nilai Minimum 60 

Rentang 20 

Banyak Kelas 6 

 






k
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2

i2 O
   

i

i

E

E
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Panjang Kleas 3,3  4 

Rata – Rata 69,24 

Simpangan Baku 5,67 

Banyak Data 33 

 

Kelas Interval 
Batas 

Z 

untuk Peluang  Luas Kls 
Ei Oi 

(Oi-Ei)² 

Kelas 
Batas 

kls. 
untuk 

Z 
untuk Z Ei 

60 - 63 59,5 -1,72 0,4570 0,1128 3,7211 7 2,8892 

64 - 67 63,5 -1,01 0,3443 0,2236 7,3802 8 0,0521 

68 - 71 67,5 -0,31 0,1206 0,2753 9,0840 6 1,0470 

72 - 75 71,5 0,40 0,1547 0,2103 6,9406 5 0,5426 

76 - 79 75,5 1,10 0,3650 0,0997 3,2908 5 0,8877 

80 - 83 79,5 1,81 0,4647 0,0293 0,9676 2 1,1016 

      83,5 2,51 0,4940     33     

                x² 6,5201 

 

Diperoleh harga          = 6,5201 

Dan untuk taraf signifikan 5% dengan    = 6-3 = 3 diperoleh 

        =  (    ) ( ) = 7,81 

Karena         <         maka Ho diterima . 

 

 

                                6,5201   7,81 

Jadi distribusi data akhir kelas kontrol berdistrbusi normal. 

 

 

 

 

 

 

Daerah  
penerimaan Ho 
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Lampiran 16 

 

UJI NORMALITAS DATA AKHIR KELAS EKSPERIMEN 

( X RPL II ) 

Hipotesis 

Ho : distribusi data akhir berdistribusi normal 

Ha : distribusi data akhir tidak berdistribusi normal 

Rumus  

 

  

Keterangan: 

   : chi kuadrat 

   : frekuensi yang diperoleh dari data penelitian 

   : frekuensi yang diharapkan 

  : banyak kelas interval 

Kriteria Pengujian 

Ho diterima jika          <        yaitu         <  (   ) (   ) dengan taraf 

signifikan ( ) =5% dan dk = (k - 3). 

Statistik Hitung 

Nilai Maksimum 93 

Nilai Minimum 60 

Rentang 33 

Banyak Kelas 6 

Panjang Kleas 5,6  6 

 






k

1i

2

i2 O
   

i

i

E

E




103 

 

 

 

Rata – Rata 80,00 

Simpangan Baku 7,55 

Banyak Data 33 

 

Kelas Interval 
Batas Z untuk Peluang  

Luas 

Kls 
Ei Oi 

(Oi-Ei)² 

Kelas 

Batas 

kls. 
untuk 

Z untuk Z Ei 

60 - 65 59,5 -2,72 0,4878 0,0572 1,8880 1 0,4177 

66 - 71 65,5 -1,92 0,4306 0,1694 5,5907 3 1,2005 

72 - 77 71,5 -1,13 0,2611 0,2412 7,9599 7 0,1158 

78 - 83 77,5 -0,33 0,0199 0,3138 10,3564 10 0,0123 

84 - 89 83,5 0,46 0,2939 0,1502 4,9563 8 1,8692 

90 - 95 89,5 1,26 0,4441 0,0520 1,7163 4 3,0385 

      95,5 2,05 0,4961     33     

                   6,6539 

 

Diperoleh harga          = 6,6539 

Dan untuk taraf signifikan 5% dengan    = 6-3 = 3 diperoleh 

        =  (    ) ( ) = 7,81 

Karena         <         maka Ho diterima . 

 

 

                                6,6539   7,81 

Jadi distribusi data akhir kelas eksperimen berdistrbusi normal. 

 

 

 

 

 

 

 

Daerah  
penerimaan Ho 
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Lampiran 17 

UJI HOMOGENITAS DATA AKHIR KELAS EKSPERIMEN 

DAN KELAS KONTROL 

Hipotesis 

Ho :     =    ( data akhir tes penguasaan konsep photoshop kelas eksperimen  

dan kelas kontrol mempunyai varians yang sama). 

Ha :     =      (data akhir tes penguasaan konsep photoshop kelas eksperimen 

                                Dan kelas kontrol mempunyai varians yang tidak sama). 

Rumus  

 

  

Kriteria Pengujian 

Ho diterima jika  Ho diterima apabila         <  
 
  (    ) (    )

dengan taraf 

signifikan 5%. 

Statistik Hitung 

Sumber Variasi  Kelompok Eksperimen Kelompok Kontrol 

Jumlah 2640 2285 

N 33 33 

Rata – Rata 80,00 69,24 

Varians 56,944 32,189 

Standart Deviasi 7,546 5,674 

Berdasarkan rumus diperoleh : 

  
                

                
 

  
      

      
 

  terkecilVarians

  terbesarVarians
  F
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        , sehingga         = 1,769 

  pembilang = nb – 1= 33 – 1 = 32 

  penyebut = nk – 1 = 33 – 1 = 32 

 (     )(     ) =2,025 

 

 

  

 

Karena         <  
 
  (    ) (    )

maka Ho diterima. 

Jadi data akhir tes penguasaan konsep photoshop kelas eksperimen dan kelas 

kontrol mempunyai varians yang sama. 
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Lampiran 18 

 

UJI PERBEDAAN DUA RATA-RATA NILAI AKHIR ANTARA 

KELOMPOK EKSPERIMEN DAN KELOMPOK KONTROL 

 

Hipotesis 

H0:  µ1   <  µ2 ( kemampuan  penguasaan konsep photoshop siswadengan  metode 

pembelajaran brainstorming kurang dari atau sama dengan 

kemampuan  penguasaan konsep photoshop  siswadengan  

metode pembelajaran tanya jawab). 

Ha  :µ1   >  µ2 (kemampuan  penguasaan konsep photoshop siswadengan  metode 

pembelajaran brainstorming lebih dari kemampuan  penguasaan 

konsep photoshop  siswamenggunakan  metode pembelajaran 

tanya jawab). 

Rumus yang dipakai: 

 

 

Dengan  

 

 

( Sudjana, 2005:239) 

21 n

1

n

1
 s

xx
 t 21






   
2nn

1n1n
  s

21

2

22

2

11






ss



107 

 

 

 

Keterangan : 

        : nilait hitung 

   : rata-rata kemampuan penguasaan konsep photoshop kelas eksperimen 

   : rata-rata kemampuan penguasaan konsep photoshop kelas kontrol 

   : banyaknya subjek kelas eksperimen 

   : banyaknya subjek kelas kontrol 

  ² : varians kelas eksperimen 

  ² : varians kelas kontrol 

S : simpangan baku gabungan 

Kriteria Pengujian 

Kriteria pengujian adalah Ho diterima jika        < (   )(       )        

diperoleh dari  table distribusi t  dengan taraf nyata 5% dan dk = (n1+ n2 - 2). 

Statistik Hitung 

Sumber Variasi Kelas Eksperimen Kelas Kontrol 

Jumlah 2640 2285 

X 80,00 69,24 

Varians 56,944 32,189 

N 33 33 

 

Sehingga diperoleh, 

  
√((    )       (    )      )

       
 

   = 6,676 

 
           

           

     √
 
  
  
 
  

 

 = 6,5456 
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Dari hasil perhitungan diperoleh harga         = 6,5456 

Untuk taraf signifikan 5% dengan dk = 33 + 33 - 2 = 64 diperoleh        = 1,998 

Karena        >      , maka H0 ditolak dan Ha diterima. 

Jadi, kemampuan penguasaan konsep photoshop siswadengan metode 

pembelajaran brainstorming lebih dari kemampuan penguasaan konsep photoshop  

siswamenggunakan  metode pembelajaran tanya jawab. 
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Lampiran 19 

 

PERHITUNGAN UJI N-GAIN NILAI KOGNITIF 

KELOMPOK EKSPERIMEN 

Rumus uji gain rata-rata ternormalisasi: 

    
  ̅          ̅        

       ̅        
 

keterangan: 

 ̅        = persentase skor rata-rata pretest 

 ̅        = persentase skor rata-rata posttest 

dengan 

 ̅        = 80,00% 

 ̅        =56,48% 

Maka : 

    
             

           
 

    
      

      
 

         

Sehingga peningkatan hasil belajar kognitif siswa kelompok eksperimen dapat 

dikategorikan sedang atau cukup signifikan. 
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Lampiran 20 

 

PERHITUNGAN UJI N-GAIN NILAI KOGNITIF 

KELOMPOK KONTROL 

Rumus uji gain rata-rata ternormalisasi: 

    
  ̅          ̅        

       ̅        
 

keterangan: 

 ̅        = persentase skor rata-rata pretest 

 ̅        = persentase skor rata-rata posttest 

dengan 

 ̅        = 69,24% 

 ̅        = 54,78% 

Maka : 

    
             

           
 

    
      

      
 

         

Sehingga peningkatan hasil belajar kognitif siswa kelompok kontrol dapat 

dikategorikan sedang atau cukup signifikan. 
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Lampiran 21 

Contoh lembar Jawab 
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Lampiran 22 

PETUNJUK PENGGERJAAN SOAL 

1. Isilah identitas Anda dalam  Lembar Jawaban yang 

tersedia. 

2. Periksa dan bacalah soal-soal sebelum Anda 

menjawabnya. 

3. Kerjakan pada Lembar Jawaban yang tersedia dengan 

cara memberi tanda silang pada jawaban yang 

dianggap paling benar. 

4. Apabila ada jawaban yang Anda anggap salah dan 

ingin memperbaikinya, tidak boleh menggunakan tip-

ex atau penghapus. 

5. Perbaikan jawaban hanya diperbolehkan paling banyak 

dua ( 2 ) kali perbaikan. 

6. Periksa kembali jabawan Anda sebelum dikumpulkan. 

 

- SELAMAT MENGERJAKAN – 

 

1. Apakah yang dimaksud Layer pada PhotoShop …. 

a. Mengatur Resolusi 

b. Mengatur Bidang Kerja 

c. Memberi Lapisan Pada Bidang Kerja 

d. Memodifikasi Warna 

 

2. Jumlah titik persatuan luas yang mempengaruhi 

ketajaman dan detail file bitmap adalah…. 

a. Intensitas 

b. Vektor 

c. Resolusi 

d. Crop  

3. Yang bukan termasuk Pallette pada PhotoShop 

adalah… 

a. Action 

b. Tool Preset 

c. Navigator 

d. Type 

4. Untuk mengukur ukuran bidang kerja digunakan…. 

a. Image > Image Size 

b. Image  > Mode 

c. Image > Rotate Canvas 

d. Image > Canvas Size 

5. Perintah yang biasanya digunakan untuk membuat 

lembar/ file baru adalah…. 

a. Menu > New 

b. Windows > New 

c. File > New 

d. Paper > New 
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6. Pallette yang digunakan untuk mengatur besar kecilnya 

tampilan ukuran gambar dalam lembar kerja (kanvas) 

adalah….. 

a. Info Pallette 

b. Navigator Pallette 

c. Layer Palette 

d. Channel Pallette 

7. Name, Width, Height, Resolution, Mode. Contents 

berada pada kotak dialog untuk mengatur…. 

a. Warna 

b. Halaman 

c. Garis 

d. Border 

8. Ketika Anda memfoto sebuah taman seperti taman 

bunga, kemudian bandingkan hasilnya dengan objek 

asli. Apakah warnanya sama? Jika tidak berarti warna 

tersebut mengalami …. 

a. Noise 

b. Blur 

c. Distorsi 

d. Absurt 

 

9. Yang dimaksud dengan rotate adalah…. 

a. Mengubah besar skala 

b. Pergeseran 

c. Membuat gambar 

d. Memutar gambar 

10. Cara-cara berikut berguna untuk melakukan 

penggandaan terhadap objek yang ada yaitu …. 

a. Copy, Transform, Duplicate 

b. Copy,Clone, Duplicate 

c. Copy, Clone, Paste 

d. Modify, Copy, Paste 

11. Kumpulan tool dengan bermacam fungsi yang 

digunakan untuk pengolahan object atau gambar 

disebut…. 

a. Palet 

b. Toolbar 

c. Toolbar Standar 

d. Toolbox 

12. Jenis transformasi yang digunakan untuk mengubah 

bentuk object adalah…. 

a. Scale 

b. Rotate 

c. Size 

d. Skew 
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13. Tool yang digunakan untuk menyeleksi objek yang 

tidak teratur adalah…. 

a. Lasso Tool 

b. Magic Wand Tool 

c. Marquee Tool 

d. Move Tool 

14. Berikut ini adalah bagian dari transformasi layer, 

kecuali… 

a. Scale 

b. Rotate 

c. Size 

d. Distort 

15. Perintah  menu Select >> Deselect digunakan untuk…. 

a. Menghilangkan seleksi 

b. Mengembalikan kembali seleksi 

c. Membalik bentuk seleksi 

d. Menyimpan hasil seleksi 

16. Untuk menduplikasi layer selain dengan  Edit> Copy 

kita bisa menekan tombol pada keyboard, yaitu… 

a. Ctrl + F 

b. Ctrl+Alt+C 

c. Ctrl+J 

d. Cltr+Shift 

 

17. Sistem warna Adobe PhotoShop yang hanya mampu 

mempresentasikan maksimal 256 variasi warna dengan 

informasi 8 bit atau kurang adalah….. 

a. Grayscale 

b. CMYK 

c. RGB 

d. Indexed color 

18. Palet Style fungsinya untuk… 

a. Menerapkan kombinasi efek-efek yang terakhir 

digunakan 

b. Mencampur dan memilih warna 

c. Memperbesar dan mengecilkan objek 

Menampilkan informasi nilai komposisi warna 

yang sedang digunakan 

19. Submenu blur berada pada menu…. 

a. Image 

b. Filter 

c. Select 

d. Layer 
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20. Fasilitas pada PhotoShop yang digunakan untuk editing 

kurva vector (bukan bimap) baik terbuka maupun 

tertutup adalah….. 

a. Photography Tool 

b. Selection Tool and Direct Selection Tool 

c. Gradient and Paint Bucket Tool 

d. Spot Healing Brush 

21. Tool yang digunakan untuk memperbaiki foto agar 

tampak seperti baru adalah… 

a. Dodge tool 

b. Paintbrush Tool 

c. Blur tool  

d. Smudge Tool 

22. Diketahui sebuah software dapat membuat sebuah 

extensi *.JPG dan *.TIF selain itu dapat pula 

melakukan pengeditan berupa gambar dan logo serta 

memanipulasi efek photo, selain itu pula software ini 

kini sudah memasuki generasi ke 14 atau juga disebut 

CS4 dari keterangan tersebut dapat diambil kesimpulan 

bahwa software tersebut…. 

a. Software desain grafis 

b. Software statistic 

c. Software desain html 

d. Software angka 

 

23.  

 

                                             Untuk menampilkan gambar 

seperti disamping yaitu... 

a. File-Color 

b. Edit-Color 

c. View-Color 

d. Window-Color 

24. Untuk menambahkan layer pada adobe photoshop yaitu 

dengan lewat menu dan submenu…. 

a. Format-New-Layer 

b. Layer-New-Layer 

c. Format-Edit-Layer 

d. File-New-Layer 

25. Fungsi Marquee Tool pada menu toolbox di adobe 

PhotoShop adalah…. 

a. Memilih bagian tertentu dari image yang akan 

dipotong 

b. Memilih atau menemukan bagian gambar yang 

sama kedalaman warnanya 

c. Memotong gambar 

d. Mengubah atau memperbaiki bagian tertentu pada 

gambar menggunakan pola dari bagian gambar lain 
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26. Tool yang digunakan untuk menggeser bidang kerja 

adalah…. 

a. Pointer Tool 

b. Move Tool 

c. Hand Tool 

d. Marquee Tool 

27. Untuk membuat alur text menjadi tegak lurus 

digunakan…. 

a. Vertikal Tool 

b. Horizontal Text 

c. Vertikal Text 

d. Vertikal Mask 

28. Adobe Photoshop termasuk dalam kategori software…. 

a. Digital Ilustration 

b. Digital Imaging 

c. Multimedia 

d. Web Design 

29. Fasilitas pada PhotoShop yang digunakan untuk 

membuat teks diatas gambar adalah … 

a. Type Tool 

b. Selection Tool 

c. Brush Tool 

d. History Brush Tool 

 

30. Untuk mengeluarkan panel transformasi dapat 

dilakukan dengan cara klik 2X pada salah satu tool 

transformasi yang ada pada toolbox, atau melalui menu 

…. 

a. Windows>Freeform 

b. Edit>Transform 

c. Edit>Freeform 

d. Modify>Transform 
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Lampiran 23 

 

Kisi – Kisi Penguasaan Konsep  Photoshop Berdasarkan Aspek 

Kognitif 

 

Indikator Tujuan Pembelajaran  

Tingkat Pengetahuan dan Nomor Butir 

C1 C2 C3 C4 C5 C6 Jml 

Membuat 

beberapa 

kreasi 

grafis 

 

 Mengatur tampilan 

ukuran dan warna 

halaman 

1, 2 3 4,5,6 - 7 - 7 

 Membuat kreasi grafis 

dengan 

menggabungkan dan 

memodifikasi garis dan 

bentuk 

9  8 

10,11, 

12, 13 

14, 

15 

16 - - 9 

 Mengatur pewarnaan 

pada grafis 

- 17 -  - - 1 

 Menerapkan efek 

sederhana dan lanjutan 

pada grafis  

18 19 20, 

21 

-  22 5 

 Melakukan pencetakan 

dan/atau penampilan 

(publish) grafis 

  23, 

24 

   2 

 Membuat desain 

template website 

25 26,27, 

28 

29 30   6 

Total        30 
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Lampiran 24 

DOKUMENTASI PENELITIAN 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pembelajaran Metode Brainstorming 

 

 

 

 

 

 

 

 
Siswa sedang berdiskusi 
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Peneliti Sedang memberikan arahan 
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                        Pembelajaran Metode Tanya Jawab 

 

 

Siswa Sedang Mengerjakan Posttest 

 

 

 

 



120 

 

 

Lampiran 25 

Surat Keputusan Pembimbing 
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Lampiran 26 

Surat Ijin Penelitian 
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Lampiran 27 

Surat Bukti Pelaksaaan Penelitian 
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Lampiran 28 

 

HASIL KOREKSI NILAI UTS  

Mata Pelajaran : Desain Grafis Tingkat - Kelas  : X RPL I 

Guru Pengampu : Anden Priyono KKM : 75 

 

No No Induk Nama Siswa Nilai 

1 
14256 

 
Achmad Saleh Argubie 

- 

2 
14257 

 
Amalia Cahya Puspita 

60 

3 
14258 

 
Ana Ifmawati 

58 

4 
14259 

 
Andi Harivianto 

52 

5 
14260 

 
Anisha Dita  Aprilliani 

76 

6 
14261 

 
Aprilia Lestari 

78 

7 
14262 

 
Bella Pinky Anggraini 

42 

8 
14263 

 
Burhanudin Syah 

68 

9 
14264 

 
Duncan Richard Pratama 

76 

10 
14265 

 
Dwi Astuti Wahyuningtyas 

58 

11 
14266 

 
Dwi Savitri 

42 

12 
14267 

 
Dyah Lathifah 

60 

13 
14268 

 
Egi Winanti Asdi 

66 

14 
14269 

 
Farhan Adhitya Putra 

65 

15 
14270 

 
Farida Aprilia 

52 

16 
14271 

 
Gurit Indra Purnama 

78 

17 
14272 

 
Maulana Safii 

50 
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18 
14273 

 
Miftah Huda Fatchur Rizqi 

65 

19 
14274 

 
Muhammad Adji F 

66 

20 
14275 

 
Muniroh 

- 

21 
14276 

 
Naufal Abdul Farhan 

76 

22 
14277 

 
Nur Cahyo Eko Prasetyo. 

60 

23 
14278 

 
Oktavia Yuni Rahmawati 

60 

24 
14279 

 
Prima Aviana 

67 

25 
14280 

 
Randy Andreanto Pramana 

80 

26 
14281 

 
Rendra Sandy Kurniawan 

78 

27 
14282 

 
Revan Ibnu Aziz Santosa 

79 

28 
14283 

 
Setiyarna Sanjaya 

- 

29 
14284 

 
Sulkhan Alfareza 

60 

30 
14285 

 
Upasara Timur 

62 

31 
14286 

 
Wahyu Gawan Trimukti 

- 

32 
14287 

 
Wahyu Prastio 

45 

33 
14288 

 
Wina Adinda Rosalia S 

76 

34 
14289 

 
Yohana Lady Catherina 

75 

35 
13290 

 
Rahmat Rafvi* 

54 

36 
13291 

 
Ranca Semesta S.* 

60 

37 1392  
Teguh Surya K.A * 

65 
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Lampiran 29 

HASIL KOREKSI NILAI UTS 

Mata Pelajaran : Desain Grafis Tingkat - Kelas  : X RPL II 

Guru Pengampu : Anden Priyono KKM : 75 

 

No No Induk Nama Siswa Nilai 

1 
14291 

 
Adef Bagas Putra 

64 

2 
14292 

 
Agung Royhans 

52 

3 
14293 

 
Anggita Nurmalasari 

60 

4 
14294 

 
Archangela Dias V 

75 

5 
14295 

 
Aulia Dinda Rosiva R 

54 

6 
14296 

 
Dani Alfandi Andik A. 

66 

7 
14297 

 
Diana Ridwani Putri 

82 

8 
14298 

 
Difa Putri Nurfana 

77 

9 
14299 

 
Dwi Prastyaningsih 

67 

10 
14300 

 
Erisal Dwi Putranto 

56 

11 
14301 

 
Fahreza Dandy Si 

60 

12 
14302 

 
Firman Adji M 

55 

13 
14304 

 
Hadid Reza Pahlevi 

66 

14 
14305 

 
Hani Addaroini Joti 

52 

15 
14306 

 
Kevin Muhammad B 

60 

16 
14307 

 
Khofifah Indah P 

58 

17 
14308 

 
Machfud Syuchri I 

77 
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18 
14309 

 
Mella Siti Noviara 

76 

19 
14310 

 
Miftahul Baiton 

65 

20 
14311 

 
Muhammad Vicky B 

60 

21 
14312 

 
Natanael Kevin P 

78 

22 
14313 

 
Nur Tiger Bunga Arum 

77 

23 
14314 

 
Puji Dewi Astutik 

64 

24 
14315 

 
Putri Rahayu Tri R 

65 

25 
14316 

 
Radiva Wahyu M 

78 

26 
14317 

 
Ramadhanu Endra G 

76 

27 
14318 

 
Rozi Fargly 

60 

28 
14319 

 
Religiawan Reksa N 

42 

29 
14320 

 
Suci Widyawati 

67 

30 
14321 

 
Syahril Dika R 

50 

31 
14322 

 
Yuliana 

56 

32 
13230 

 
Andika Tria Asmara* 

60 

33 
13271 

 
Arfian Kresmanto* 

66 
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Lampiran 30 

LEMBAR PENILAIAN AFEKTIF X RPL I 
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Lampiran 31 

LEMBAR PENILAIAN AFEKTIF X RPL II 
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Lampiran 32  

Panduan Penilaian 

 
Sangat baik  : Jika muncul 5-6 deskripsi sikap yang terdapat pada rubrik pengamatan afektif (skor = 3) 

Baik    : Jika muncul 3-4 deskripsi sikap yang terdapat pada rubrik pengamatan afektif (skor = 2) 

Kurang Baik  : Jika muncul 1-2 deskripsi sikap yang terdapat pada rubrik pengamatan afektif (skor = 1) 
 

Kriteria Penilaian 

 
Sangat baik  : skor 14 - 18 

Baik   : skor 9 – 13 

Kurang baik   : skor 4 – 8 

RUBIK PENGAMATAN AFEKTIF 

 

NO SIKAP DESKRIPTIF NO SIKAP DESKRIPTIF 

1 Kejujuran 

1. Tidak mencontek dan mengerjakan ujian/ulangan 

2. Tidak melakukan plagiat 

3. Menyampaikan sesuatu berdasarkan keadaan yang sebenarnya 

4. Melaporkan dan atau informasi apa adanya 

5. Mengakui kesalahan atau kekurangan yang dimiliki 

6. Mengakui kemampuannya yang kurang dalam materi tertentu 

4 Peduli 

1. Menjaga kebersihan kelas 

2. Membantu teman yang membutuhkan 

3. Menunjukkan rasa empati dan simpati untuk ikut menyelesaikan masalah 

4. Mampu memberikan ide terhadap suatu masalah yang ada disekitarnya 

5. Memberikan bantuan sesuai dengan kemampuannya 

6. Menghormati guru dan teman-temannya 

2 Disiplin 

1. Masuk kelas tepat waktu 

2. Mengumpulkan tugas tepat waktu 

3. Mengerjakan tugas yang diberikan 

4. Tertib dalam mengikuti pelajaran 

5. Membawa buku teks mata pelajaran 

6. Menaati seluruh peraturan sekolah 

5 Kerjasana 

1. Mengerjakan tugas kelompok dengan sungguh-sungguh 

2. Menunjukkan sikap bersahabat 

3. Berusaha menemukan solusi permasalahan secara bersama dlm kelompoknya 

4. Menghargai pendapat lain 

5. Berkontribusi dalam kegiatan kelompok 

6. Membantu teman satu kelompok ketika tidak bisa menyelesaikan masalah 

3 Tanggungjawab 

1. Melaksanakan tugas individu dengan baik 

2. Menerima resiko dari tindakan yang dilakukan 

3. Tidak menuduh orang lain tanpa bukti kuat yang akurat 

4. Mengembalikan barang yang dipinjam 

5. Partisipasi dalam kelompok 

6. Selalu menjaga nama baik kelompok 

6 Percaya Diri 

1. Berani tampil didepan kelas 

2. Berani perpendapat 

3. Bertanya atau menjawab pertanyaan 

4. Berpendapat atau melakukan kegiatan tanpa ragu-ragu 

5. Mampu  membuat keputusan dengan cepat 

6. Tidak canggung dalam bertindak 
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Lampiran 33 

LEMBAR PENILIAN AKTIVITAS SISWA KELAS X RPL I 
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Lampiran 34 

LEMBAR PENILIAN AKTIVITAS SISWA KELAS X RPL II 
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Lampiran 35 

RUBIK PENGAMATAN PSIKOMOTORIK SISWA 

NO JENIS KEGIATAN INDIKATOR PENGAMATAN KRITERIA SKOR KET 

1 Memperhatikan 

Kurang memperhatikan guru (melamun, tidak bisa menjawab ketika ditanya ) Kurang memperhatikan 1 KB 

Cukup memperhatikan guru (hanya memperhatikan tanpa melakukan apapun) Cukup memperhatikan 2 B 

Memperhatikan dengan seksama Sering memperhatikan 3 SB 

2 

Oral Activities 

1. Mengeluarkan 

pendapat 

2. Bertanya 

3. Memberi saran 

Kurang aktif ( melakukan 1 aktivitas dari aktivitas tersebut) Kurang aktif 1 KB 

Cukup aktif  (melakukan  2 aktivitas dari aktivitas tersebut) Cukup aktif 2 B 

Aktif ( melakukan minimal 3 aktivitas dari aktivitas) Aktif 3 SB 

3 Mendengarkan 

Kurang mendengarkan ( tidak bisa menjawab jika diberi pertanyaan) Kurang mendengarkan 1 KB 

Cukup mendengarkan  ( dapat menjawab ketika diberi pertanyaan) Cukup mendengarkan 2 B 

Mendengarkan (dapat menjawab ketika diberi pertanyaan dan dapat menjelaskan 

kembali materi yang disampaikan) 

Mendengarkan 3 SB 

4 Mencatat 

Kurang mencatat ( hanya ketika diperintah) Kurang mencatat 1 KB 

Cukup mencatat ( hanya mencatat hal  yang dianggap penting) Cukup mencatat 2 B 

Aktif mencatat ( mencatat dengan detail) Aktif mencatat 3 SB 

5 

Aktivitas Motorik 

1. Aktif melakukan 

percobaan/ referensi 

2. Mengamati 

3. Menganalisa 

Kurang aktif (melakukan 1 aktivitas dari aktivitas tersebut) Kurang aktif  1 KB 

Cukup aktif (melakukan 2 aktivitas dari aktivitas tersebut) Cukup aktif 2 B 

Aktif ( melakukan semua aktivitas) aktif 3 SB 
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6 

Aktivitas Mental 

1. Menanggapi 

2. Mengingat 

3. Memecahkan masalah 

Kurang aktif (melakukan 1 aktivitas dari aktivitas tersebut) Kurang aktif  1 KB 

Cukup aktif (melakukan 2 aktivitas dari aktivitas tersebut) Cukup aktif 2 B 

Aktif ( melakukan semua aktivitas) aktif 3 SB 

7 

Emotional Avtivities 

1. Menaruh minat dalam 

proses belajar mengajar 

2. Berani menyampaikan 

hasil didepan  teman-

teman 

3. Terlihat senang dalam 

proses belajar mengajar 

Kurang aktif (melakukan 1 aktivitas dari aktivitas tersebut) Kurang aktif  1 KB 

Cukup aktif (melakukan 2 aktivitas dari aktivitas tersebut) Cukup aktif 2 B 

Aktif ( melakukan semua aktivitas) aktif 3 SB 

Sardiman A.M. 2001. Interaksi dan Motivasi Belajar Mengajar. Jakarta : Rajawali Press 

 


